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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the X5 / X5 PRIME OCS module manufactured by
HE-APG is free from defects in material and workmanship under normal use and service. The obligation of HE-APG
under this warranty shall be limited to the repair or exchange of any part or parts which may prove defective under normal
use and service within two (2) years from the date of manufacture or eighteen (18) months from the date of installation by
the original purchaser whichever occurs first, such defect to be disclosed to the satisfaction of HE-APG after examination
by HE-APG of the allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER
WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR
AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH
THE SALE OF THIS X5/ X5 PRIME OCS MODULE. THIS WARRANTY SHALL NOT APPLY TO THIS X5/ X5 PRIME
OCS MODULE OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE,
ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES NO WARRANTY WHATSOEVER IN RESPECT TO
ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE TERM "ORIGINAL PURCHASER", AS USED IN THIS
WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON FOR WHOM THE X5/ X5 PRIME OCS MODULE IS
ORIGINALLY INSTALLED. THIS WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE
CONTINENTAL UNITED STATES.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall HE-APG or
its suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit
or revenues, loss of use of the products or any associated equipment, damage to associated equipment, cost of capital,
cost of substitute products, facilities, services or replacement power, down time costs, or claims of original purchaser's
customers for such damages.

To obtain warranty service, return the product to your distributor with a description of the problem, proof of purchase, post
paid, insured and in a suitable package.

To obtain warranty service, return the product to your distributor with a description of the problem, proof of
purchase, postpaid, insured and in a suitable package.

ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying diskettes are included solely
for illustrative purposes. Due to the many variables and requirements associated with any particular installation, Horner
APG cannot assume responsibility or liability for actual use based on the examples and diagrams. It is the sole respons-
ibility of the system designer utilizing the X5/ X5 PRIME OCS module to appropriately design the end system, to appro-
priately integrate the X5/ X5 PRIME OCS module and to make safety provisions for the end equipment as is usual and
customary in industrial applications as defined in any codes or standards which apply.

NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine
operation is the sole responsibility of the system integrator.



HORNER

AUTOMATION GROUP

PREFACE

This manual explains how to use the X5/ X5 PRIME OCS.

Copyright (C) 2016 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All rights reserved. No part
of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any lan-
guage or computer language, in any form by any means, electronic, mechanical, magnetic, optical, chemical, manual or
otherwise, without the prior agreement and written permission of Horner APG, Inc.

All software described in this document or media is also copyrighted material subject to the terms and conditions of the
Horner Software License Agreement.

Information in this document is subject to change without notice and does not represent a commitment on the part of
Horner APG.

Cscape, SmartStack, SmartStix, SmartRail, and CsCAN are trademarks of Horner APG. Ethernet is a trademark of Xerox
Corporation®.

microSD® and CompactFlash are registered trademarks of SanDisk Corporation®.

Published with Madcap Flare®.

North America

Tel: (+) (317) 916-4274

Fax: (+) (317) 639-4279

Web: http://www.hornerautomation.com
Email: techsppt@heapg.com

Europe

Tel: (+) 353-21-4321-266

Fax: (+) 353-21-4321-826

Web: http://hornerautomation.eu

Email: technical.support@hornerapg.com
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Safety and Compliance

Warnings

When found on the product, the following symbols specify:
A Warning: Consult user documentation. A Warning: Electrical Shock Hazard.

WARNING: EXPLOSION HAZARD - Substitution of components may impair suitability for Class I, Division 2.
WARNING: EXPLOSION HAZARD - Do not disconnect equipment unless power has been switched off or the
area is known to be non-hazardous.

1. To avoid the risk of electric shock or burns, always connect the safety (or earth) ground before making any
other connections.

2. To reduce the risk of fire, electrical shock, or physical injury it is strongly recommended to fuse the voltage
measurement inputs. Be sure to locate fuses as close to the source as possible.

3. Replace fuse with the same type and rating to provide protection against risk of fire and shock hazards.

4. Inthe event of repeated failure, do not replace the fuse again as a repeated failure indicates a defective con-
dition that will not clear by replacing the fuse.

5. Only qualified electrical personnel familiar with the construction and operation of this equipment and the haz-

ards involved should install, adjust, operate, or service this equipment. Read and understand this manual

and other applicable manuals in their entirety before proceeding. Failure to observe this precaution could res-

ultin severe bodily injury or loss of life.

NOTE: All applicable codes and standards need to be followed in the installation of this product.
NOTE: For I/0O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG or larger.
NOTE: See the "Electrical Installation" on page 20 for more details.

FCC Compliance

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired oper-
ation.

Safety Precautions

Adhere to the following safety precautions whenever any type of connection is made to the module:

Il applicable codes and standards need to be followed in the installation of this product. Adhere

to the following safety precautions whenever any type of connection is made to the module:

Connect the safety (earth) ground on the power connector first before making any other connections.
When connecting to the electric circuits or pulse-initiating equipment, open their related breakers.

Do NOT make connection to live power lines.

Make connections to the module first; then connect to the circuit to be monitored.

Route power wires in a safe manner in accordance with good practice and local codes.

Wear proper personal protective equipment including safety glasses and insulated gloves when making con-
nections to power circuits.

Ensure hands, shoes, and floor are dry before making any connection to a power line.

Make sure the unit is turned OFF before making connection to terminals.

Make sure all circuits are de-energized before making connections.

Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if defective.
Use copper conductors in Field Wiring only, 60/75°C.

ook wn =

—
o0 N
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12. Use caution when connecting controllers to PCs via serial or USB. PCs, especially laptops may use “floating
power supplies” that are ungrounded. This could cause a damaging voltage potential between the laptop and
controller. Ensure the controller and laptop are grounded for maximum protection. Consider using a USB isol-
ator due to voltage potential differences as a preventative measure.

Page 9 of 173
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Intro to the X5 & X5 Prime

VISUAl OV OV W 1
Where to find more information forthe X5 & X5 Prime ... 12
Connectivity tothe X5 & XS Prime ... . 12
Features of X5/ XG Prime O C S .. 12

Visual Overview

—_

Power

Input Connector
Output Connector
CAN Port

Serial Ports

DIP Switches
Ethernet Port
microSD Slot
USB A Port

USB Mini-B Port

COXNIOARLLDN =
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Where to find more information for the X5 & X5 Prime

Datasheet - The datasheet is the first documents to refer to for key information related to specific models. (A basic
datasheet is provided in the box with the unit.) . Find MAN1040 via the Documentation Search page on the Horner
website.

Connectivity to the X5 & X5 Prime

Connectivity
CAN 110 UsB Serial Ethernet
Other OCS Devices| Sensors Flash Drive Other OCS Devices Cscape
SmartStix I/O Indicators Cscape Drives OPC Server
SmartBlock I/0 Alarms PLCs Modbus TCP Devices
SmartRail I/0 Encoders Printers
OPC Pumps SCADA
Relays OPC Server
Solenoids Portal
I/O Devices
SmartRail Devices

Features of X5/X5 Prime OCS

The X5 /X5 PRIME OCS are all-in-one industrial control devices. They combine control, user interface, /0 and net-
working into a single, integrated package. Unique features of the X5/ X5 PRIME OCS include:

Bright, 65K color graphical touch sensing LCD display

Display of complex graphical objects including trends, gauges, meters and animations

High performance graphic processing

Advanced control capabilities including floating point, multiple auto-tuning PID loops and string handling cap-
abilities

Removable media for FAT32 format (up to 2TB) of storage of programs, data logging or screen captures
CsCAN networking port for communication with remote 1/O, other controllers or PCs

High speed USB port for communication with PCs and programming of controller

Configurable serial protocols for communication to drives, PLCs, or other serial peripherals

Full featured, built-in I/O including high resolution analog, high speed counter inputs, and PWM outputs
Advanced high speed I/O capabilities

Cscape programming software that allows all aspects of the X5/ X5 PRIME OCS to be programmed and con-
figured from one integrated application

On board Ethernet port (10/100Mbps) for Cscape programming and application defined communication, with
Auto MDI/MDI-X

Page 12 0f 173
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Mechanical Installation

Mounting ReqUiremMeNnts ... ... ... 14
Mounting Orientation ... 15
DIMEeNSIONS ... .. 16
Installation Procedure ... 16
Factors Affecting Panel Layout Design and Clearances ............................................................... 17
Onboard Battery .. ... 18

The mechanical installation greatly affects the operation, safety and appearance of the system. Information is
provided to mechanically install the unit such as cut-out sizes, mounting procedures, and other recommendations
for the proper mechanical installation of the unit.

NOTE: The datasheet is the first document to refer to for model-specific information related to X5 & X5 Prime mod-
els such as pin-outs, jumper settings, and other key installation information. See the Documentation Search for the
datasheet.

Mounting Requirements

Once the panel design has been completed using the criteria and suggestions in the following sections, use the fol-
lowing steps to panel mount the X5/X5 Prime OCS.

1. Carefully locate an appropriate place to mount the X5. Be sure to leave enough room at the top of the unit for
insertion and removal of the microSD™ card.

2. Carefully cut the host panel per the diagram , creating a 90.5mm x 119.5mm (with a tolerance of +/- 0.5mm)
opening into which the X5 may be installed. If the opening is too large, water may leak into the enclosure,
potentially damaging the unit. If the opening is too small, the OCS may not fit through the hole without dam-
age.

3. Remove any burrs and or sharp edges and ensure the panel is not warped in the cutting process.

4. Install and tighten the four mounting clips (provided in the box) until the gasket forms a tight seal. For stand-
ard composite mounting clips (included with product), use a torque rating of 2-3 in-Ibs (0.23- 0.34 Nm). For
optional metal mounting clips, use a torque rating of 4-8 in Ibs (0.45-0.90 Nm).

5. Connect communications cables to the serial port, USB ports, and CAN port as required.

Page 14 of 173
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Mounting Orientation

NOTE—For panel or DIN rail mounting: The orientation shown above provides for optimum readability of the
screen and ease of use of the keypad.

Page 150f 173
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Dimensions

379"
(96mm)

1.22"
492" (125mm) (31tmm)

3.56"

P Cut-Out
(90.5mm) anel bty

470" (119.5mm)

Panel Tolerance: +/- 0.5mm

Installation Procedure

This equipment is panel mounted and is meant to be installed in an enclosure suitable for the environment,
such that the back of the equipment is only accessible with the use of a tool.

Requires a Class 2 Power Source.

This equipment is suitable for use in Class I, Division 2, Groups A, B, C and D; Class Il, Division 2 Groups F
and G; and Class lll Hazardous Locations or Non-Hazardous Locations only.

The X5 utilizes a clip installation method to ensure a robust and watertight seal to the enclosure. Follow the
steps below for the proper installation and operation of the unit.

Please following the steps below for the proper installation and operation of the unit:

1.

2.

5.

Carefully locate an appropriate place to mount the X5. Be sure to leave enough room at the top of the unit for
insertion and removal of the microSD™ card.

Carefully cut the host panel per the diagram , creating a 90.5mm x 119.5mm (with a tolerance of +/- 0.5mm)
opening into which the X5 may be installed. If the opening is too large, water may leak into the enclosure,
potentially damaging the unit. If the opening is too small, the OCS may not fit through the hole without dam-
age.

Remove any burrs and or sharp edges and ensure the panel is not warped in the cutting process.

Install and tighten the four mounting clips (provided in the box) until the gasket forms a tight seal. For stand-
ard composite mounting clips (included with product), use a torque rating of 2-3 in-Ibs (0.23- 0.34 Nm). For
optional metal mounting clips, use a torque rating of 4-8 in Ibs (0.45-0.90 Nm).

Connect communications cables to the serial port, USB ports, and CAN port as required.

Page 16 of 173



I.I HORNER

AUTOMATION GROUP . .
Mechanical Installation

Factors Affecting Panel Layout Design and Clearances

WARNING: It is important to follow the requirements of the panel manufacture and to follow all applicable electrical
codes and standards.

The designer of a panel layout must assess the requirements of a particular system and to consider the following
design factors.

Clearance / Adequate Space

Install devices to allow sufficient clearance to open and close the panel door.

Minimum Clearance Requirements for Panel Box and Door
Minimum Distance between base of device and sides of cabinet 27 (50.80mm)
Minimum Distance between base of device and wiring ducts 1.5” (38.10mm)
If more than one device installed in panel box (or on door): 4” (101.60mm) between bases of each
Minimum Distance between bases of each device device
When door is closed:
Minimum distance between device and closed door 2”(50.80mm)
(Be sure to allow enough depth for the OCS.)

Grounding

Panel Box: The panel box must be properly connected to earth ground to provide a good common ground ref-
erence.

Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that they have
the same ground reference.

WARNING: Be sure meet the ground requirements of the panel manufactuer and also meet applicable electrical
codes and standards.

Temperature / Ventilation

Ensure that the panel layout design allows for adequate ventilation and maintains the specified ambient tem-
perature range. Consider the impact on the design of the panel layout if operating at the extreme ends of the ambi-
ent temperature range. For example, if it is determined that a cooling device is required, allow adequate space and
clearances for the device in the panel box or on the panel door.

Noise

Consider the impact on the panel layout design and clearance requirements if noise suppression devices are
needed. Be sure to maintain an adequate distance between the OCS and noisy devices such as relays, motor
starters, etc.

Shock and Vibration

The OCS has been designed to operate in typical industrial environments that may inflict some shock and vibration
on the unit. For applications that may inflict excessive shock and vibration please use proper dampening techniques
or relocate the OCS to a location that minimizes shock and/or vibration.

Page 17 of 173
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Panel Layout Design and Clearance Checklist
The following list provides highlights of panel layout design factors:

Meets the electrical code and applicable standards for proper grounding, etc.?

Meets the panel manufacturer’s requirements for grounding, etc.?

Is the panel box properly connected to earth ground? Is the panel door properly grounded? Has the appro-
priate procedure been followed to properly ground the devices in the panel box and on the panel door?
Are minimum clearance requirements met? Can the panel door be easily opened and closed? Is there
adequate space between device bases as well as the sides of the panel and wiring ducts?

= [s the panel box deep enough to accommodate the controller?
= [s there adequate ventilation? Is the ambient temperature range maintained? Are cooling or heating devices

required?

Are noise suppression devices or isolation transformers required? Is there adequate distance between the
base of the controller and noisy devices such as relays or motor starters? Ensure that power and signal wires
are not routed in the same conduit.

Are there other requirements that impact the particular system, which need to be considered?

Onboard Battery

The X5 /X5 PRIME OCS is unique from any other Horner Controller in that there is no battery-backed memory of
any kind on the product. The onboard lithium battery runs the real time clock, is non-replaceable, and is designed to
last the lifetime of the product (greater than 10 years). None of the system registers allocated to battery indication
apply to the X5/ X5 PRIME OCS. The onboard battery is soldered to the unit and cannot be removed.

WARNING: Lithium Batteries may explode or catch fire if mistreated.
WARNIN: Do not disassemble, heat above 100°C (212°F), incinerate, or puncture.

Page 18 of 173
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Electrical Installation

Ground Specifications ... ... . . 20
How to Test for Good Ground ... ... .. . 20
Primary Power Port ... 21

NOTE: The datasheet is the first document to refer to for model-specific information. Refer to the Documentation
Search on the Horner website.

Ground Specifications

Ideally, a ground resistance measurement from equipment to earth ground is 0Q. In reality it typically is higher. The
US National Electrical Code (NEC) states the resistance to ground shall not exceed 25Q. Horner Automation recom-
mends less than 15Q resistance from the equipment to ground. Resistance greater than 25Q can cause undesir-
able or harmful interference to the device.

Grounding Definition - The term Ground is defined as a conductive connection between a circuit or piece of equip-
ment and the earth. Grounds are fundamentally used to protect an application from harmful interference causing
either physical damage such as by lightning or voltage transients or from circuit disruption often caused by radio fre-
quency interference (RFI).

How to Test for Good Ground

In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance Meter
Kit contains a meter, two or three wire leads, and two ground rods. Instructions are supplied for either a two-point or
a three-point ground test. The figure shows a two-point ground connection test.

GROUND RESISTANCE METER
] Vo

¢ ® 9

GROUND | / t S G B

DISCONNECTED o
FROM SERVICE

GROUND ROD

METAL WATER PIFE OR
OTHER GOOD GROUND
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Primary Power Port
NOTE: The Primary Power Range is 10VDC to 30VDC.

Primary Power Port Pins
PIN Signal Description
Ground | Frame Ground
DC- | Input Power Supply Ground
DC+ | Input Power Supply Voltage

WIN| =

DC Input / Frame
¢ Solid/Stranded Wire: 12-24 awg (2.5-0.2mm)
¢ Strip length: 0.28” (7mm)
¢ Torque, Terminal Hold-Down Screws: 4.5 — 7 in-Ibs (0.50 — 0.78 N-m)
¢ DC-isinternally connected to I/0 V-, but is isolated from CAN V-. A Class 2 power supply must be used.

Power Up
1. OPTION: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the DC supply that

is powering the controllers.

2. Connect to earth ground.
3. Apply recommended power.

Page 21 0f 173
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System Settings and Adjustments

Opening System MeNU ...
OCS LED Indicator Lights ... ..
System MeNU ...
Set NetWOIKS ... .
VieW Status & Diags ... ...
View l/O Slots & Protocols ...
Set Keys, Serial Ports, Ethernet, Time/Date, Beeper & Screen ........................................................
Removable Media ...
Fail — Safe System . .
Clone UNit ...

Press the far upper right
corner to bring out the
function keys and SYSTEM

Main Menu.
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OCS LED Indicator Lights&

The X5/X5 Prime has a built-in System Menu, which lets the user view System Settings and makes adjustments. To
start the System Menu, press the SYSTEM key (or set %SR3 to 1), which will display the Main Menu. Then use the
1 and | (Up Arrow or Down Arrow) keys to select a Main Menu item and press Enter (Return Arrow) to display the
item’s Sub-Menu.

See table below
for RUN and OK
LED information.

View Status
View Diags
View Battery Status
View 1/0 Slots

View Protocols

Set Fkeys Hode

Set Serial Ports
Set Time/Date

Set Beeper

Set Screen
Removable HMedia
Fail-Safe System
Clone Unit

OCS LEDs

® OFF indicates OCS is in IDLE/STOP mode.
® Flashing indicates DO / IO mode or RUN with no ladder program.

AL = ON indicates ladder code running.
®  OFF indicates one or more self-tests failed.
OK ® ON indicates all self-tests passed.

® Flashing at 1 Hz indicates forcing is active.

Page 24 of 173
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System Menu

Sub-Menus

ChRN Ok? Yas
CRN ID: 253
CAN Baud: 125 EB

Enakle CREN Bower Mo

Sub-Menus

MI1:
{Hone Loaded)

(Hone Loaded)

COR:
{Hone Loaded)

MAC ID:
00:-00:00-00:00:00
IE: 152.1e8.0.1
HetM: a.0.0.0
Gathy: a.o.o.0
Model HE-X5 /
#5 ERIME
OCE Mode: Idle
Scan Rate(mS): 0.0
Lol Het Use(®): 0.0
Rl1l Wet Use(®): 0.0
Ladder Size: 2
Config Size: &
Graphics Ez: g
String Size: g
Bitmap Size: a8
Text Thl Size: =}
Font Thl Size: g
Protocol Size: g
SME File Size: g
Firmware Rewv: 1418
FEGLE Rewv: 0.3
InitRD Rew: 1.07
08 Ver: Z.8.35.43
Logic Error: ak
TUser Program: Ok
TUzer Graphics: ak
W-Dog Trips: a
Net Errors: a
NHetwork State: Qk
Network ID: Ok
Dup Het ID: Ok
Clock Errcr: Qk
I/Q0 System: ak
Battery: Ok

Set Hetworks
View Status
View Diags

View I/0 Elocts
View Protoecols
Sat Fkeys Mode
Set Serisl Ports
Set Tim=/Date
Set Beeper

Set Ecreen
Eemovable Medis
Fail-Safe System
Clone Unit

(Pre=ssz ESC to Exit)

Flkeyz: Momentary
Svs-Fn enable: Yas

| Usa 3t o adjust |

Slot 1: I/0: HE-X5 /
H5 DRIME

Elot 2: I/0: Empty

Slot 3: L/0: EIN30D

Beeper Enable: Yes

[ U=ze T oea adjust |

Backup/Bestore Data
Enakle AutoRun
Enakle AutoLoad

[(EEC to exit)
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{ Tze 4T to adjust |

Time: 10:21:38
Date: 28-Jun-2005%
Day: Thur=day
UIC

Daylight Savings Time

[ Us= T eo adjust |
¥ geach field 1

Saver enable: Yasz
Timesut (min) : 15
Popup Status: Off
Update Time (mS]: =)

Update time sets ths

maximim time used by

graphics in the logic
SCarn.

Medis Directory
Media Card Hot Presant

Directory Empty
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Navigation and Editing

Set Networks

UView Status

View Diags

View Battery Status Tand | Keys
View I/0 Slots

View Protocols

set Fkeys Hode

Set Serial Ports

Set Time/Date

Set Beeper

Set Screen

Removable Media

Fail-Safe System

Clone Unit Enter Key

As mentioned above, the System Menu is started by pressing the System key on the X5/X5 Prime. Next press ESC
to exit the System Menu, or use 1 and | to select an item and press the Enter key to display the item’s Sub-Menu.

A Sub-Menu generally shows a list of System Settings and their values. After opening a Sub-Menu, if any of its Sys-
tem Settings are editable, the first System Setting that can be edited is highlighted. If desired, thet and | keys can
be used to select a different System Setting to be edited.

At this point, either press ESC to exit the Sub-Menu (returning to the Main Menu) or press Enter to edit the high-
lighted System Setting. If Enter is pressed, the System Setting’s value will be highlighted, indicating that it is ready
to be modified.

When modifying a System Setting’s value, use either the arrow keys ( |1 — « ) or the numeric keys, or the appro-
priate touch screen icons to select a new value.

@2

(v)

The arrow keys are used to edit System Settings that have just a few possible values. Each time the arrow key is
pressed, a new possible value is displayed. When the desired value appears, press the Enter key to save it; oth-
erwise press the ESC key to cancel the edit.

The numeric keys are normally used to enter numeric System Settings:

In addition, to edit a single numeric digit, use the — or « key to select the digit and then either press a numeric key
or use | or 1 to modify the digit. In any case, after entering the new desired value, press the Enter key to save it; oth-
erwise press the ESC key to cancel the edit.
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Set Networks

CAN OKk?

CAN Baud:
Enable CAN Power

00:E0:C4:0

This sub menu allows setting for the CAN and Ethernet network to be viewed or changed.

Yes = CAN1 connected to a CAN network and functioning properly

P
CAN Ok? No = Not ready to communicate on CAN network

CANID 110 253 = This node’s CsCAN Network ID; must be unique on network

125kB = 125kBd CAN network
250kB = 250kBd CAN network

el LT 500kB = 500kBd CAN network

1MB = 1MBd CAN network
MAC ID Displays the Ethernet MAC ID of the unit
IP Displays the Ethernet IP address of the unit
NetM Displays the Ethernet net mask of the unit
GatWy Displays the Ethernet gateway of the unit

NOTE: The IP address, Net Mask, and Gateway can be changed from the System Menu. This is designed for com-
missioning or temporary field changes. The actual parameters are defined in Cscape under the Ethernet con-
figuration.

NOTE: The downloaded program overrides settings made in the System Menu.
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View Status & Diags

View Status

Model :
Mode :
Scan Rate{m$):

Lcl NHet Use(%):
All Net Use(%):

Ladder Size:
Config Size:
Graphics Size:
String Size:
Bitmap Size:
Text Tbhl Size:
Font Thl Size:
Protocol Size:
SHMS File Size:
Firmware Rev:
FPGA Rew:
InitRD Reu:

System Settings and Adjustments

The View Status Sub-Menu displays up to 19 System Settings. Only the Mode System Setting is editable.

Model: HE-X5 = Model number of this X5 / X5 PRIME OCS unit
Idle = X5/ X5 PRIME OCS is in Idle mode
OCS Mode: DolO = X5/ X5 PRIME OCS is in Do I/0 mode
Run = X5/ X5 PRIME OCS is in Run mode
Scan Rate(mS): 0.0 = X5/ X5 PRIME OCS is notin Run mode
0.1 to 999.9 = Average number of mS for each ladder scan
OCS Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by this X5/ X5 PRIME OCS node
All Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by all nodes
Ladder Size: x = Number of bytes in application ladder program
Config Size: x = Number of bytes in application I/O configuration
Graphics Size: x = Number of bytes in application graphic screens
String Size: x = Number of bytes in application string table
Bitmap Size: x = Number of bytes in application bitmaps
Text Thl Size: x = Number of bytes in application text tables
Font Tbl Size: x = Number of bytes in application font tables
Protocol Size: x = Number of bytes in application downloaded protocols
SMS File Size: x = Number of bytes in application SMS protocol configuration
Firmware Rev: xx.yy = Current firmware version
FPGA Rev: x.y = Current FPGA version (High Speed I/0O Sub System)
OS Ver: a.b.cd.yz = Current Operating System version
InitRD Rev: x.yz = Bootloader version
Ok = All power-on self-tests passed
SeliFves: Fault = CF))ne or more power-gn self-tests failed
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View Diags

Logic Error:
User Program:
User Graphics:
W-Dog Trips:
Net Errors:
Network State:
Hetwork ID:
Dup Het ID:
Clock Error:
[/0 System:
Battery:

The View Diags Sub-Menu displays up to 11 System Diagnostics, none of which are editable.

The first two System Diagnostics are critical. If any of them indicate a Fault condition, the X5/X5 Prime OCS will not
enter or remain in Run mode, and the problem must be investigated and corrected.

Ok = All executed ladder instructions are legal for loaded firmware
Fault = A ladder instruction not supported by firmware was found
Ok = Ladder program and I/O configuration loaded successfully
Fault = Ladder program or I/O configuration not loaded or load failed

Logic Error:

User Program:

The last nine System Diagnostics are informational. If any of them indicate a Warning condition, the X5/X5 Prime
OCS can still enter and remain in Run mode, but the problem should be investigated and corrected.

User Graphics Ok = Applica_tioq graphics_ objegts loaded successfully _

Fault = Application graphics objects not loaded or load failed

. 0 = Watchdog timer has not tripped since the last power-u

A DIEE T2 x = Number c?f times watchdogptri)mer has tripped i P
Net Errors 0 = No CAN network bus-off errors have occurred

x = Number of CAN network bus-off errors that have occurred
Network State Ok = ,_At least one other node was found on the CAN network

Warning = No other nodes were found on the CAN network
Network 1D Ok = '_I'his nodg’s CAN Network ID is in the range 1 to 253

Warning = This node’s CAN Network ID was out of range at power-up
Dup Net ID Ok = This nod.e’s Network ID is unique on Ithe CAN network

Warning = This node’s Network ID is duplicated in another node
Clock Error Ok = Time an_d date have been set

Warning = Time and date need to be set
/O System Ok = I./O configurati_on mgtches the install_ed I/0 and CQM modules

Warning = I/O configuration needs updating to match installed modules
Battery Ok = I.3ackup battery operating properly

Warning = Backup battery needs to be replaced
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View |/O Slots & Protocols
View I/O Slots

Slot 1: I/0: HE-XS
Slot 2: I/0: Empty
Slot 3: I/0: ETN300

System Settings and Adjustments

The View I/O Slots Sub-Menu displays three System Settings, all of which are not editable.

Slot 1: | Built-in I1/0
Slot 2: [ Unavailable
Slot 3: | Ethernet
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View Protocols

See also: "Protocol Configuration " on page 116

MJ1:
{None Loaded)

MJ2 -
{None Loaded)

COM:
{None Loaded)

The View Protocols Sub-Menu displays three System Settings, none of which are editable.

As mentioned in Downloadable Serial Communication Protocols section, both the MJ1 (Port 1) and MJ2 (Port 2)
serial ports support downloadable protocols. To assign a downloadable protocol to an X5/X5 Prime OCS serial port,
select the Protocol Config item in Cscape’s Program menu and then setup a protocol for Port 1 or Port 2 (or both).

In the View Protocols Sub-Menu, the currently downloaded protocol, if any, and its version number are displayed for
both Port 1 and Port 2.

Port 1

Protocol Name (None Loaded) or name of the protocol assigned to MJ1
Protocol Version Blank or version of the protocol assigned to MJ1

Port 2

Protocol Name (None Loaded) or name of the protocol assigned to MJ2
Protocol Version Blank or version of the protocol assigned to MJ2
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Set Keys, Serial Ports, Ethernet, Time/Date, Beeper & Screen

Set Fkeys Mode

SYS-Fn enable:

{ Use LT to adjust )

The Set Fkeys Sub-Menu displays two System Settings, both of which are editable.

Momentary = %K1-5 bits go On & Off as F1-F5 are pressed & released

Fkeys Toggle = %K1-5 bits toggle each time F1-F4 are pressed

SYS Fnenable Yes = Reset and all clear system functions enabled
- No = Reset and all clear system functions disabled
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Set Serial Ports

See also: "Serial Communications" on page 1

Df1t Pgm Port

MJ2 RS485 Bias

( Use It to adjust )

The Set Serial Ports Sub-Menu displays three System Settings, all of which are editable, and one optional item. For
the Dflt Pgm Port System setting, only MJ1-232 can be selected.

Dflt Pgm Port MJ1-232 = MJ1 RS232 port is the default programming port

. No = MJ2 RS485 bias resistors are not switched in
R Bl Yes = MJ2 RS485 bias resistors are switched in
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Set Time/Date

The following instructions are to set and display the real-time clock in the controller. More details can be found in the
Help File in Cscape.

Clock and Time Setting Terms

Coordinated Universal Abbreviated to UTC, Coordinated Universal Time is the primary time standard by
Time (UTC) which the world regulates clocks and time.

In order to obtain the local time (anywhere in the world), the user needs to subtract /
Time Offset add a certain number of hours from UTC depending on how many time zones user is

away from Greenwich.

Network Time Protocol A Networking Time Protocol (NTP) for clock synchronization between computer sys-
(NTP) tems over packet-switched, variable latency data networks.

Time as adjusted to achieve longer evening daylight, especially in summer, by setting
the clocks an hour ahead of the standard time.

Daylight Saving Time (DST) is the practice of setting the clocks forward one hour from
standard time during the summer months, and back again in the fall, in order to make

Daylight Saving Time

Apply Daylight Saving

(DST) better use of natural daylight. Selecting this option increases the Time offset by 1 hour.
System Registers for UTC (Coordinated Universal Time)
%SR210 (R/W) Time Zone: setin hours +/- UTC.
Daylight Saving: YES =1
%SR211 (R/W) Daylight Saving: NO =0
(If daylight saving is enabled, one hour will be added to the local time).
%SR212 (R) UTC - Seconds
%SR213 (R) UTC — Minutes
%SR214 (R) UTC — Hours
%SR215 (R) UTC - Date
%SR216 (R) UTC — Month
%SR217 (R) UTC - Year

Local Time

Time Zone:
Daylight Saving:

{ Use IT to adjust )
{ each field )

To Set Time Zone: The Time Zone setting is an hourly offset from UTC time. If using the Time Zone setting, set it
first, then set the local time. UTC time will be automatically set based on the time zone and local time settings.
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If using NTP: NTP utilizes UTC time, therefore when using NTP, the appropriate hourly offset from UTC time must
entered into the time zone setting.

Daylight Saving Time: If currently observing Daylight Saving Time, set to Yes. If not currently observing Daylight
Saving Time, set to No, the OCS controller does not automatically switch to daylight saving time; however, program
logic can be written to accomplish an automatic switchover using system register %SR211. In program logic, move
a“1” (INT) into %SR211 to enable Daylight Saving Time. Move a “0” (INT) into %SR211 to disable Daylight Saving
Time. Trigger the move to %SR211 based on a compare function to the RTC date according to daylight saving prac-
tices in your desired region.

To Set Local Time: The Set Time/Date sub-menu displays three system settings. Time and Date may be edited,
and Day is automatically calculated from the Date setting.

NOTE: Time and Date are split into three fields each, all of which may be edited. Touch the field or use | or 1 but-
tons to select a field, then use the | or 1 buttons to edit the field.

Time 16:09:49 = Current time (hours:minutes:seconds in 24-hour format)
Date 10-Jun-2013 = Current date (day-month-year)
Day Monday = Current day of week calculated from the Date setting
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Set Beeper

Beeper enable:

( Use .7 to adjust )

The Set Beeper Sub-Menu displays one System Setting, which is editable.

Yes (default) = Enables beeper
No = Disables beeper (does NOT affect ladder access)

Beeper Enable
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Set Screen

The Set Screen Sub-Menu displays four System Settings, all of which are editable.

Timeout(min):
Popup Status:
Update Time(mS):

Update time sets
the maximum time
used by graphics

in the logic scan.

Yes = Enable screen saver

SENED Ol No (default) = Disable screen saver

5 - 1200 = Amount of time in minutes to expire with NO touch activity before activating screen

Timeout (min) saver (black screen)

Off (default) = Disable popup status

Warning = Display popup status only if controller status changes to NOT Ok or NOT Run
mode.

On = Display popup status on any controller status change.

Popup Status

Update Time (mS) | 2 - 50 = Maximum amount of time to allow for graphics update per scan

NOTE: The built-in screen saver function will not relight the screen unless the touchscreen is touched. There is no
automatic re-light of the screen in case of alarms or other conditions that may need to be enunciated on the screen.
For these instances, the application code may generate a positive-transition “1-shot” to %SR57.16 (1 bit only) to re-
light the screen in case of alarms or other notifications.
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Removable Media

See also: "Removable Media" on page 144

Media Directory

ALARKM_03 .CSV 115 06-03-15 5:02p
AUTOLOAD .PGH 21389 06-04-15 3:30p
CLIENTS .C3V 149 06-17-15 3:37p
CLONE .DAT 24570 D6-04-15 3:30p
SCROOO .BHP 261174 07-05-16 2:42p
SCROO .BHP 261174 07-05-16 2:43p
SCROO2 .BHP 261174 07-05-16 2:43p
SCROD3 .BHP 261174 07-05-16 2:43p
SCRODY .BHP 261174 07-05-16 2:43p
SCROOS .BHP 261174 07-05-16 2:43p
v

ALARM_03

Free: I 2088928 Total: 2096768

A v Del For Save
«J Del A1l mat Pgm Esc

The Removable Media Sub-Menu displays the Removable Media Manager. After selecting Removable Media from
the Main Menu, one of four Sub-Menu screens will appear:

Media Directory
Ho Card

Mo microSD card has been installed in the Memory slot

Media Directory

micro5SD card is installed, but it is still initializing

Initializing

Media Directory

s microsD card is installed and initialized, but contains no files
Dir Empty

T = microSD card is installed and initialized. and it contains files

Shows size of highlighted file or shows <DIR: if directory is highlighted.
Shows the date file or directory was created or last modified.
hows the time file or directory was created or last modified.

SCROOGY .JFC 17561 07-10-08
Froe: [ S11672320 Total:
Scrollbar

If a directory name is highlighted, pressing Enter will switch to that directory showing its files and sub-directories. In
a sub-directory, highlighting .. (dot dot) and pressing Enter will move up one directory.
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Fail — Safe System

See also: "Fail-Safe System" on page 154

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of
"soft" failures. These "soft" failures include:
= Battery power loss
® Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive EMI, Elec-
tromagnetic Interference, event.

Selecting “Fail-Safe System” menu will open the following menu screen:

Backup/Restore Data

Enable AutoRun
Enable AutolLoad

(ESC to exit)

Selecting Backup/Restore Data displays the following screen in:

Backup/Restore Data

Backup Restore

Clear Backup

Exit

Backup = Copies battery-backed RAM contents on to the onboard flash memory of the OCS.
Restore = Copies the backed-up data from onboard flash to the battery-backed RAM.

Clear Backup = The backup data will be erased from the onboard flash.

Exit = Goes back to previous menu
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Enable AutoRun

“Enable AutoRun” displays the following options which can be selected:

Enable AutoRun

( #**%%¥CAUT I ON**%%%%)
( Auto Enters RUN )
{ after AutolLoad )
{ or Battery Fail )

Enable AutoRun No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.
Yes = OCS will automatically be placed into RUN mode after AutoLoad or Automatic Restore.
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Enable AutoLoad

“Enable AutoLoad” displays the following options which can be selected:

Enable Autoload

{ AutoLoad from )
{ Removable Media’®s )
{ AUTOLOAD.PGH file )
( when triggered )

No = Does not load AUTOLOAD.PGM automatically when application program is absent

Enable AutoLoad or corrupted.
Yes = Loads AUTOLOAD.PGM file automatically from RM when application program is

absent or corrupted.
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Clone Unit

See also: "Clone Unit" on page 150

‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” application
program and unit settings stored in battery-backed RAM of an OCS into the RM. Refer to "Removable Media" on
page 144 for details on using RM. It can then be used to clone a different OCS (same model).

This feature can be used for:
® Replacing an OCS by another unit of the same model.
= Duplicating or “clone” units without a PC.

Make Clone

Selecting “Clone Unit” menu will open the following menu screen:

wE D b [ ) Q1] =0
Al Save Application
CL
Ea Are You Sure?
FI
FI
OE Ok I Cancel I
0]
v
WEBHI
Free: | 7629388 Total: | 7688120
Load | Make
Clone Clone V A Esc

Load Clone and Make Clone virtual buttons are below the screen. Free/Total: Displays number of Free and Total
bytes in Removable Media.

Selecting Make Clone brings up the screen below for the user:

WEBHI <DIR> 09-22-15 11:67a
AUTOLOAD.PGH 218545 09-22-15 16:17a
CLONE .DAT 109178 09-22-15 10:17a
EXL10E 1797901 08-14-15 10:02a
FILE . INF 9 09-21-15 4:52p
FIRMWARE.LIC 128 09-21-15 5:24p
OEH . INF 9 09-21-15 4:52p
OEMINFO .TXT 168 04-13-12 7:16p
w

WEBHMI
Free:] 7629540 Total: I 7688120

Load Make

Clone Clone v A Esc
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After confirmation, the OCS will create two new files in the root directory of the Removable Media Drive as shown

below:
AUTOLOAD.PGH 2120 07-14-09 12:11a
CLONE .DAT 24570 07-14-09 12:11a
Free: | 1004208128 Total: | 1004257280
Load | Mak | | | |
(H lt:lal'l -] I:lao nee v A Esc
AUTOLOAD.PGM Application file
CLONE.DAT File having all unit settings and register values from battery-backed RAM
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Load Clone

Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone” (one of the virtual buttons
beneath the screen).

Clone Unit

AUTOLOAD .PGH 2120 07-14-09 12:11a
CLONE .DAT 24570 07-14-09 12:11a

Free: 1004208128 Total: 1004257280

NOTE: For security enabled files, Load Clone asks for password validation before loading the application.
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WebMI License Details

Server Running

License details page displays the information about the WebMI license. Please refer to MAN1036 for the WebMI
Manual using Horner's Documentation Search page. The information can also be viewed from Cscape using the fol-
lowing %SR registers:

%SR209.3 WebMI server status
%SR209.4 WebMI user logged in status
%SR209.9 to SR209.16| Number of Users

%SR218 Number of Webpages
%SR219 Number of Data Points
%SR220-SR222 Expiry Date of WebMI License
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Touch Screen Calibration

The touch screen is calibrated at the factory and rarely needs modification. However, if actual touch locations do not
appear to correspond with responding objects on the display, field adjustment is available. To access the field
adjustable touch screen calibration dialog, press the far upper right corner of the touchscreen to bring out the func-
tion keys, then press and hold the SYSTEM key for longer than five (5) seconds and a menu with several advanced
functions will appear. Select TOUCH CALIBRATION to calibrate the touch screen.

TOUCH CALIBRATION

SYSTEH UPGRADE

RESET

AUTO LOAD
| CLEAR APPLICATION |
| EXIT |

NOTE: Advanced options, accessed by holding the system key down, may be locked out from user access. If hold-
ing the SYSTEM key does NOT respond, verify that the system menu’s Set Fkeys sub-menu’s parameter SYS_Fn
is enabled.

For best results in screen calibration, use a stylus with a plastic tip. When the crosshair appears, touch the center of
the crosshair as exactly as possible and release. A small “+” should appear and will move closer to the center of the
crosshair. Once it has done so and disappeared again, repeat the process until “+” appears in the center of the
crosshair. Then move on to the next step.

Touch Calibration Screen T. é Touch Calibration Screen

Touch cresshair with stylus,
calculated touch point will appear
and will auto align with crosshair.
—(———  Repeat until touch point and crosshairs
no lenger need alignment to match.

Please touch extreme,
Top-Right corner point

Touch Calibration Screen Touch Calibration Screen

Touch crosshair with stylus,
calculated touch point will appear
and will auto align with crosshair. _'_-> Save new calibration?

Repeat until touch point and crosshairs
no longer need alignment te match.

‘ Yes I | Ho I

vl -

Page 46 of 173



II HORNER

AUTOMATION GROUP

System Registers

PPPPPP



I.I HORNER

AUTOMATION GROUP :
System Register Tables

System Register Tables

Register Definitions
oS RIS OIS .
oS R RegiS OIS
1/0 Register Map for X5 & X5 Prime
X5 & X5 Prime Resource Limits

There are two types of System Registers that may be used during programming. %S registers indicate the status of
several system operations. %SR registers indicate the state of many system operations and can be used to control

them in several cases. Some of the system registers have predefined I/O names, though they may still be chang
if desired.

Register Definitions

When programming the an OCS, data is stored in memory that is segmented into different types. This memory in
the controller is referred to as registers. Different groups of registers are defined as either bits or words (16 bits).
Multiple registers can usually be used to handle larger storage requirements. For example, 16 single-bit registers
can be used to store a word, or two 16-bit registers can be used to store a 32-bit value.

ed

Types of Registers

16-bit input registers used to gather analog input data such as voltages,

o
fita temperatures, and speed settings coming from an attached device.

= Analog Input

16-bit output registers used to send analog information such a voltages,

o =
(0BG (O levels or speed settings to an attached device.

These are digital flags used to control the displaying of screens on a unit
which has the ability to display a screen. If the bitis SET, the screen is dis-
played.

%D = Display Bit

Single-bit input registers. Typically, an external switch is connected to the

%I = Digital Input registers

%K = Key Bit

Single-bit flags used to give the programmer direct access
to any front panel keys appearing on a unit.

%M = Retentive Bit

Retentive single-bit registers.

%Q = Digital Output

Single-bit output registers. Typically, these bits are connected to an actuator,

indicator light or other physical outputs.

%R = General Purpose
Register

Retentive 16-bit registers.

%S = System Bit

Single-bit bit coils predefined for system use.

%SR = System Register

16-bit registers predefined for system use.

%T = Temporary Bit

Non-retentive single-bit registers.
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%S Registers

%S registers indicate system status as follows:

System Register Tables

S# Name Predefined Notes

I/0 Name
%S1 First Scan FST_SCN On for 1 scan only each time the program is first run
%S2 Network OK NET_OK If on, the Network is OK
%S3 10ms pulse T_10MS Cycling pulse that is high for 5ms and low for 5ms
%S4 100ms pulse T_100MS Cycling pulse that is high for 50ms and low for 50ms
%S5 1secondpulse | T_1SEC Cycling pulse that is high for 500ms and low for 500ms
%S6 I/0 OK I0_OK If on, the I/O system is OK
%S7 Always On ALW_ON This bit is always on
%S8 Always OFF ALW_OFF This bit is always off
%S9 Pause Scan PAUSING_SCN On for at least 1 scan prior to Pause 'n Load
%S10 Resume Scan RESUMED_SCN | On for 1 scan only after Pause 'n Load is done
%S11 Forcing Present| FORCE If on, I/O is presently being forced
%S12 Forcing Enabled] FORCE_EN If on, 1/O forcing is been enabled
%S13 Net I/O OK NET_IO_OK If on, Network I/O is OK
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%SR Registers

%SR registers are special word-length registers that display and/or control system operations in the controller. Not
all controllers support all defined system registers. Click on the name of the register to see more information on that

register.

SR #

Name and Description

Default 110
Name I/O Name

Min - Max
Values

Program
(Read/Write)

Display
(Read/Write)

%SR1

User Screen Number (0=none)

USER_SCR

0to 1023

Read/Write

Read/Write

%SR2

Alarm Screen Number

ALRM_SCR

0to1-23

Read Only

Read Only

%SR3

System Screen Number

1 = Main System Menu

2= Set Network ID, Network Status,
(%SR29)

3= Set Network Baud (%SR30)

4= Set Contrast (%SR32)

5= View OCS Status

6= View OCS Diagnostics

7= View I/O Slots

8= Set Function Key Mode (%SR33)
9= Set Serial Ports (%SR34)

10= Set Time/Date (%SR44-%SR50)
11= Set Beeper (%SR183)

12=Set Screen (%SR185)

13= Removable Media

14= View Protocols

15=IP Address IP Address (ETN I/O
Board)

16= Fail Safe System

17=Backup / Restore Data

18= Enable AutoRun

19= Enable AutoLoad

20= Clone Unit -

21=Touch Calibration

24= License Details

SYS_SCR

Oto24

Read/Write

Read/Write

%SR4

Self Test Results

SELF_TEST

Read Only

Read Only

%SR4.1

Self Test Results - BIOS Error

Read Only

Read Only

%SR4.2

Self Test Results - Engine Error

Read Only

Read Only

%SR4.3

Self Test Results - Ladder Error

Read Only

Read Only

%SR4.4

Self Test Results - RAM Error

Read Only

Read Only

%SR4.5

Self Test Results - Duplicate ID Error

Read Only

Read Only

%SR4.6

Self Test Results - Bad ID Error

Read Only

Read Only

%SR4.7

Self Test Results - I/O Configuration Error

Read Only

Read Only

%SR4.8

Self Test Results - Bad Network Error

Read Only

Read Only

%SR4.9

Self Test Results - Bad Logic Error

Read Only

Read Only

%SR4.10

Self Test Results - Bad Clock Error

Read Only

Read Only

%SR4.11

Self Test Results - DeviceNet Error

Read Only

Read Only

%SR4.12 -
16

Reserved

%SR5

Control Station Mode
0=Idle

1=Dol/O

2=Run

3= Online Change

CS_Mode

Oto3

Read Only

Read/Write

%SR6

Average Scan Rate ms (/10)

Read Only

Read Only
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%SR7 Minimum Scan Rate ms (/ 10) Read Only Read Only
%SR8 Maximum Scan Rate ms (/ 10) Read Only Read Only
%SR9 Current Touch Pressure TCH_PRESSURE| 0 to 3000 Read Only Read Only
%SR10 Threshold Touch Pressure TCH_ 0 to 3000 Read/Write Read/Write
PRESSURE_TSH

%SR11-12 | Ladder Size (32-Bit DINT) Read Only Read Only
%SR13-14 | User Text Screen Size (32-Bit DINT) Read Only Read Only
%SR15-16 | System Text Screen Size (32-Bit DINT) Read Only Read Only
%SR17-18 I/O Configuration Table Size (32-Bit DINT) Read Only Read Only
%SR19-20 | Network Config Table Size (32-Bit DINT) Read Only Read Only
%SR21-22 Security Data Table Size (32-Bit DINT) Read Only Read Only
%SR23 Ladder Code CRC Read Only Read Only
%SR24 User Text CRC Read Only Read Only
%SR25 System Text CRC Read Only Read Only
%SR26 I/0O Configuration Table CRC Read Only Read Only
%SR27 Network Configuration Table CRC Read Only Read Only
%SR28 Security Data Table CRC Read Only Read Only
%SR29 Network ID Read Only Read/Write

CsCAN Mode NET_ID 110253

DeviceNet Mode 0to 63

CANopen Mode 1t0 127
%SR30 Network Baud Rate Oto4 Read Only Read/Write

0=125KB

1=250kB

2=5000KB

3=1MB

4=50K
%SR31 Network Required Oto3 Read Only Read Only

0= Network not required

1= Network required;

2= Network optimized;

3= Network required and optimized

%SR32 LCD Display Contrast setting 0to 255 Read Only Read/Write

%SR33 Function Key Toggle Mode Oto1 Read/Write Read/Write
0= Momentary
1=Toggle

%SR34 RS232 Serial Protocol Mode Read Only Read Only
0= Firmware Update (RISM)

1= CsCAN

2= Generic (Ladder- Controlled)
3= Modbus RTU

4= Modbus ASCII

%SR35-36 | Unique Serial Number / Hexadecimal Read Onl Read Onl
ILAN1 MAC ID y y
%SR37 Model Number Read Only Read Only
%SR38 Engine Version (/100) Read Only Read Only
%SR39 BIOS Rev Number (/100) Read Only Read Only
%SR40 FPGA Image Rev Number (/ 10) Read Only Read Only
%SR41 Vertical Pixel Count Read Only Read Only
%SR42 Horizontal Pixel Count Read Only Read Only
%SR43 Keypad Type Read Only Read Only
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%SR44

Real-Time-Clock Second

RTC_SEC

0to59

Read Only

Read Only

%SR45

Real-Time-Clock Minute

RTC_MIN

0to59

Read Only

Read Only

%SR46

Real-Time-Clock Hour

RTC_HOUR

0to23

Read Only

Read Only

%SR47

Real-Time-Clock Date

RTC_DATE

1 to 31

Read Only

Read Only

%SR48

Real-Time-Clock Month

RTC_MONTH

1t012

Read Only

Read Only

%SR49

Real-Time-Clock Year

RTC_YEAR

1996 to
2095

Read Only

Read Only

%SR50

Real-Time-Clock Day (1=Sunday)

RTC_DAY

1t07

Read Only

Read Only

%SR51

Network Error Count

Read Only

Read Only

%SR52

Watchdog-Tripped Error Count

Read Only

Read Only

%SR53-54

Reserved

%SR55.13

Self-Test: Battery Low or Missing

Read Only

Read Only

%SR56

Key Currently Pressed
No key = 0 (No key pressed since power-
up) F1=1
F2=2

F3=3

F4=4

F5=5

F6=6

F7=7

F8=8

F9=9

F10=10
F11=11
F12=12
Enter=13
+/-=14
.(dot)=15
0=16

1=17

2=18

3=19

4=20

5=21

6=22

7=23

8=24

9=25

System = 26
Escape =27
Left=28

Right = 29

Up =30

Down = 31
Shift = 32
SoftKey 1=34
Soft Key 2 =35
Soft Key 3 = 36
Soft Key 4 =37
Soft Key 5 =38
Soft Key 6 =39
Soft Key 7 =40
Soft Key 8 =41
Release = 255 (Keys pressed since
power-

up but not currently)

LAST_KEY

0to 255

Read Only

Read Only

%SR57

LCD Backlight Dimmer Register
0-100 = 0% to 100% On

0to 255

Read Only

Read Only
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100-255=100% On

%SR57.16 | Temporarily disable Screen Saver Read/Write Read/Write
%SR58 User LEDs USER_LEDS Read/Write Read/Write
%SR59 Engine Build Number Read Only Read Only
(Only last three numbers displayed)
%SR60 Build Option Oto2 Read Only Read Only
Build Test=0
Build Beta = 1
Build Product =2
%SR61 Number of CsCAN Network IDs NUM_IDS Read Only Read Only
%SR62-130 Reserved
%SR131-135| OCS Model: ASCII, 10 characters Read Only Read Only
%SR136 Communication Download Timeout Read Only Read Only
%SR137 Communication Idle Timeout Read Only Read Only
%SR138-148 Reserved
%SR149-150| Free-running 10kHz count: 1 count = Read Only Read Only
0.1ms
(32-Bit DINT)
%SR151 Reserved
%SR152 RS-485 Termination Read/Write Read/Write
%SR152.1 MJ2 Termination Enable Read/Write Read/Write
%SR153 - Reserved
163
%SR164 FailSafe / Clone
%SR164.1 RS485 Port Biasing #1 (MJ1 or MJ2) Read/Write Read/Write
%SR164.2 RS485 Port Biasing #2 (MJ2 or MJ3) Read/Write Read/Write
%SR164.3 | Indicates Automatic Restore Oper- AUTO_RESTRD Read Only Read Only
ation
has been performed
%SR164.4 | Indicates Backup of Registers has been BCKUP_TAKN Read Only Read Only
taken
%SR164.5 | Enable AUTORUN — Sets “Enable EN_AUTO_LD Read/Write Read/Write
AutoRun” to “Yes” or “No”
%SR164.6 | Enable AUTOLOAD - Sets “Enable EN_AUTO_LD Read/Write Read/Write
AutolLoad” to “Yes” or “Not”
%SR164.7 | Start Backup trigger bit — STRT_BCKUP Read/Write Read/Write
Setting TRUE starts backup of all
register data
%SR164.8 | Clear Backup trigger bit — Setting CLR_BACKUP Read/Write Read/Write
TRUE
clears backup of all register data
(if a backup was done previously)
%SR164.9 | MAKE_CLONE trigger bit = MAKE_CLONE Read/Write Read/Write
Setting TRUE does a Load Clone
(if a media card is present)
%SR164.10 | LOAD_CLONE trigger bit — LOAD_CLONE Read/Write Read/Write

Setting TRUE does a LOAD CLONE
(if a media card is present that con-
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tains clone files)

%SR164.11 | Make Clone Fail MK_CLN_FL Read/Write Read/Write
(This bit goes high when Make/Create
Clone fails)
%SR164.12 | Load Clone Fail LD_CLN_FL Read/Write Read/Write
(This big goes high when Load Clone
fails)
%SR164.14 Reserved Read/Write Read/Write
%SR164.15 Reserved Read/Write Read/Write
%SR165-166 Reserved
%SR167 Screen Update Time, Default=5 2t050 Read/Write Read/Write
%SR168-170 Reserved
%SR171 X-Coordinate Touched Read Only Read Only
%SR172 Y-Coordinate Touched Read Only Read Only
%SR173 System-Function Disable Oto1 Read/Write Read/Write
%SR174 Removable Media Protect Read/Write Read/Write
%SR174.1 Request Media Card be Removed Read/Write Read/Write
%SR174.2 Indicates safe to remove Media Card Read/Write Read/Write
%SR175 Removable Media - Status Read Only Read Only
%SR176-177| Removable Media Free Space (32-Bit Read Only Read Only
DINT)
%SR178-179| Removable Media Total Space (32-Bit Read Only Read Only
DINT)
%SR180 Reserved
%SR181 Bits 1-16 indicate Unacknowledged in ALM_UNACK Read Only Read Only
Alarm Groups 1-16
%SR182 Bits 1-16 indicate Active in Alarm Groups ALM_ACT Read Only Read Only
1-16
%SR183 Beep on Keypress Enable SYS_BEEP Oto1 Read/Write Read/Write
0= Disabled
1=Enabled
%SR184 Internal Beeper USER_BEEP Oto1 Read/Write Read/Write
0=OFF
1=ON
%SR185 Screen Saver Enabled Oto1 Read Only Read Only
0= Disabled
1=Enabled
NOTE: See %SR57.16
%SR186 Screen Saver Time in minutes (delay) 5t0 1200 Read Only Read Only
%SR187 Network Usage (Avg) NET_USE 0to 1000 Read Only Read Only
%SR188 Network Usage (Min) 0to 1000 Read Only Read Only
%SR189 Maximum Net Usage of all units on the 0to 1000 Read Only Read Only
CAN network
%SR190 Network TX Usage % (/ 10) (Avg) NT_TX_AVG 0to 1000 Read Only Read Only
%SR191 Network TX Usage % (/ 10) (Min) 0to 1000 Read Only Read Only
%SR192 Network TX Usage % (/ 10) (Max) 0to 1000 Read Only Read Only
EXTENDED SYSTEM REGISTERS
%SR193 Online Change ONLINE_CHG
%SR193.1 | TRUE if 2 programs in target FLASH Read Only Read Only
%SR193.2 | TRUE to switch programs, FALSE when Read Only Read Only
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complete
%SR193.3 | TRUE if executing program is temporary Read Only Read Only
test
%SR193.4 | TRUE during last scan of switched-from Read Only Read Only
program
%SR193.5 | TRUE during first scan of switched-to pro- Read Only Read Only
gram
%SR193.6 | TRUE to revert to FLASH and delete Read Only Read Only
all RAM;
FALSE when complete
%SR193.9 | TRUE if error in temporary program Read Only Read Only
%SR194 Battery Charge Temp Low Read Only Read Only
%SR195 Battery Charge Temp High Read Only Read Only
%SR196 Charging State O0to 11 Read Only Read Only
NOTE: Refer to MAN1142 for more details
on Rechargeable Batteries
0=Waiting
1=Normal Charging
2=Hot Charge
3=Hot Charge
4= Battery Hot
5= Cold Charge
6=Battery Cold
7=No Battery
8= Not Charging (after 8 hours of char-
ging)
9= CPU Hot, not charging
10 Battery voltage <2V, not charging
11= First 2 minutes Init Wait (Not Char-
ging)
%SR197 Charging Current Max mA Read Only Read Only
%SR198 Battery Voltage is mV Read Only Read Only
%SR199 Reserved
%SR200 InitRD Version (/100) Read Only Read Only
%SR201 - Linux Kernel version: ASCII, 10 char- Read Only Read Only
205 acters
%SR206-208 Reserved
%SR209.3 | WebMI Server Status. Bit 3 is ON if server Read Only Read Only
running.
%SR209.4 | WebMI User Logged in Status. Read Only Read Only
Bit 4 is ON if 1 or more users logged
in.
%SR209.8 - | Number of Users. Read Only Read Only
209.14 Shows in upper byte in decimal
format.
%SR210 Time Zone: setin minutes +/-UTC Read/Write Read/Write
(Ex: EST is -4 hours =-240 minutes)
%SR211 Daylight Saving: YES =1 Read/Write Read/Write
Daylight Saving: NO = 0
(If daylight saving is enabled,
one hour will be added to the local time).
%SR212 UTC - Seconds Read Only Read Only
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%SR213 UTC - Minutes Read Only Read Only
%SR214 UTC - Hours Read Only Read Only
%SR215 UTC - Date Read Only Read Only
%SR216 UTC - Month Read Only Read Only
%SR217 UTC - Year Read Only Read Only
%SR218 Number of Webpages, license detail Read Only Read Only
%SR219 Number of Data Points, license detail. Read Only Read Only
%SR220-222| Expiration Date of WebMI License, Read Only Read Only

license detail
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I/0 Register Map for X5 & X5 Prime

Fixed Starting Address Digital/Analog 1/0O Function X5 / X5 PRIME
o Digital Inputs 1-4
%l Reserved 5-16
o Digital Outputs 1-4
el Reserved 5-16
0 Analog Inputs 1-4
%Al Reserved n/a
X5 & X5 Prime Resource Limits
Resource Value
%S 13
%SR 192
% T 2048
%M 2048
%R 8192 (%R1 - %R1024 Retentive)
%K 4
%D 1023
%l 2048
%Q 2048
Y%Al 512
%AQ 512
Ethernet CsCAN, Ping, EGD, SRTP, Modbus TCP Master & Slave,
Ethernet IP, FTP, HTTP, SMTP @ 10 Mbps or 100 Mbps
CsCAN 125 kbps, 250 kbps, 500 kbps, or
1 Mbps
Serial Ports 1 RS-232, 1 RS-485 Ports
IDs Per CsCAN Network 64 w/o repeaters (253 w/ 3 repeaters)
Keypad 5 virtual keys (4 function keys and a System Key)
Display 480 x 272 4.3” Widescreen TFT, 64K colors
Screen Memory 64 MB
User Screens 1023
Data Fields Per User Screen 1023
Ladder Logic Memory 2MB
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Cscape Configuration

Cscape StatUS Bar ... ..
Establishing Communications
Communicating via MJ1 Serial Port .............................
Communicating via On Board Ethernet Port
Communicating via CSCape ... ... ...
Cscape Configuration

X5/X5 Prime OCS hardware is programmed with a Windows based PC application called Cscape. This application
can be used to program, configure, monitor, and debug all aspects of the X5/X5 Prime OCS unit. Please see the
Online Help provided with Cscape for additional details.

Cscape Status Bar

When the X5/X5 Prime OCS is connected to a PC using Cscape software, a Status Bar appears at the bottom of the
screen. The Cscape Status Bar can be used to determine if communications have been established between the
X5/X5 Prime OCS and the Cscape program. Components of the Cscape Status Bar are explained below:

Message Line -
The contents of
these messages

Equal Indicator - indicates whether the current program in Cscape is equal to the program
stored in the Target Controller.

are context + |f Equal, the program in Cscape is the same as the program stored in the Target Controller.
sensitive. The * |f Not Equal, the program in Cscape is not the same as the program stored in the Target
Message line can Controller.

be empty. + |f Unknown, there may have been a change since the last time the program in Cscape was

compared to the Target Controller.

File Modified Indicator - indicates that the file in
the selected window has been modified but has
not been saved.

Current User -
indicates who is logged
(for secrrit\,r purposes).

HE-XExx1-CsCAN
(Model=)

Local :1 MOD

forces]

User:
NONE

Ready Equal Target :2(R) [no

Controller Model - Network (Model Confirmation) Communications Status - indicates the current status of the
“pass through” Connector.
. Controller Model indicates the controller model for

which the program in Cscape is configured. s Local xx - indicates the Network ID of the OCS to which

the Cscape program is physically connected through its

. Network indicates the type of network that the

program in Cscape expects to use (e.q., CsCAN).

(Model Confirmation) provides the following
indications:

(Model=) - The actual Target Controller matches the
configured Controller Model and Network.

(Model Not=) - The actual Target Controller does not
match the configured Controller Model and Metwork.

(Model ?) - There may have been a change since the
last time the Target Controller was compared to the
configured Controller Model and Network.

serial port. It can serve as a pass-through device to other
nodes on the network.

Tarqget: yy(R) - indicates the Network ID of the device with
which the Cscape program is exchanging data.
NOTE: The Local unit and Target unit can be the
same unit, or they can be separate units.

The following are status indicators:

(R) - Running

(D)-Do /O

(- ldle

(?) - Cscape is not communicating with the remote unit.
[no forces] - indicates no I/0 has been forced.
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Establishing Communications

The X5/X5 Prime OCS can communicate with Cscape using USB to USB, USB to serial adapters, serial port com-
munications via MJ1 Port, Ethernet (with an Ethernet adapter board), onboard Ethernet Port, CAN (CsCAN), or
modems.

Otherwise, the drivers may be loaded from the HE-XEC Ethernet Utility / HTTP Web Server Demo / Com-
munications Drivers section of the support files page found on our website.

Support files:
North America https://hornerautomation.com/support-files
Europe https://www.hornerautomation.eu/support/

Next, connect a PC’s (Personal Computer running a Windows Microsoft operating system) USB port via USB cable
to the USB mini B port on the X5/ X5 PRIME OCS.

User Programming Port:

=

The PC will detect a new device has been plugged into the USB port.

Now that the X5/X5 Prime is plugged in, go to Cscape > Controller > Connection Wizard. If you are just opening
Cscape, Connection Wizard usually opens by default.

Connection Wizard X

How is your PC connected to the local controller?

-

.,

® Serial " LAN " Modem " USB

[~ Show connection wizard on startup. ‘ Next >> Cancel

Select USB and click Next >>.
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Connection Wizard X
~ Configure
USE list LUSB Serial Port [COMS) ~| | Don't Know |
[V Show connection wizard on startup. << Back | Finish I Cancel

If the Connection Wizard does not pop up upon opening Cscape, then select Controller (in the Cscape tool bar) >
Connection Wizard, choose your connection method. If you are connecting for the first time, we suggest con-
necting via USB.

[=] Fle Edt Program
FEECCHE
Project Toolbox
Bitwise Operations

Boolean Elements
Compare Operatia

" Seiial " Ethermet

B ®|®

®

Conversion Opera [~ Show connection wizard on startup.

Math Operations

Move Operations
Simple Elements

B e ®

Configure

Timer/Counter Op| | USB it Controller USB COM Port (COM32) N -l
Special Operations
Removable Media

®

®|®

[~ Show connection wizard on startup.

If Controller USB COM Port is not present in the dropdown list, the Windows operating system has not yet recog-
nized the OCS as an installed device. Be sure the installation process is complete and that the correct drivers are
installed. The Connection Wizard must be completely closed and reopened to refresh the USB dropdown list.
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An alternate way to select the COM setting is to go to Cscape > Tools > Application Settings > Communication
> Configure and choose connection method in Add Target.

Cscape - [EGD Node1]
&) Fle Edt Pogam Contoler Debug | Toos | Screens View Window Hebp

| = | 2o B[R(8] omE

B
9

Anplication Settings

Communication Settings

Communications  |NameDefaull
USE Serial Port [COMZ)
Timeowut:1000
Add Target
Target Name: IDeladl
— Connection Medium
Ccompor [T
 Ethemnet 192 . 168 . 254 . 12 Port  |1E501 Mode: | Built-in/ETN Ethemet Mode
Configue>> | Helpr P LK (T
Ean |cams0n =1
© Installed Modem | =]
Phone Numbes |
& UsE |USE Serisl Port (COM1) -]
— Connected Device
@ CorvectedDevics " TargetNode ID [1 ::I
- C fion Settings
M i Baud Fate: IS?S'ZIJ vl
Timegut: {1000 s
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Communication Configuration Dialog

Target Name

Name for connection. This is not a mandatory column to be filled, by default Cscape will pop-
ulate ‘Default1’ in edit box.

Connection Medium

Com Port

Select this option to communicate over serial communication with the device. The port num-
ber can be configured here.

Ethernet

Select this option to communicate over Ethernet. Provide the IP address of the device and
select the mode: HE GSM GPRS mode, Built in/ ETN Ethernet mode, or HE XEC Ethernet
mode.

Select HE GSM GPRS mode if communication with XL series controller on GPRS is
required and the device has GSM modem installed in XL series controller.

Select Built in/ ETN Ethernet mode if the device has on-board Ethernet port.

Select HE XEC Ethernet mode if the device has Ethernet comm. option board installed in XL
series controller.

NOTE: For GPRS connectivity, GPRS configuration from Programs a Messaging 8 GPRS
needs to be done.

NOTE: The controller should support the type of connectivity selected and configured for
Ethernet communication.

CAN Interface

Select this option to communicate over CAN. This option requires additional hardware to be
installed with the PC to be able to do so. Select the type of hardware installed from the drop-
down.

Installed Modem

Select this option to communicate to the device through the internal modem of the computer.
Cscape will automatically detect the internal modem attached with PC and list in the
attached drop down. User can select modem and telephone number for target controller.
NOTE: Cscape will do necessary initialization for the selected internal modem.

usB

Select this option to communicate over USB. Now Horner devices and Horner USB to serial
converters are recognized and can be specifically selected.

Connected Device

NOTE: This configuration is required if the controller to which Cscape is communicating is connected to a CsCAN

network.

Connected Device

By default, this option is selected and networking feature of Cscape is disabled.

Target Node ID

On selecting this option, Networking feature of Cscape is enabled. CsCAN ID for the target
controller to be provide here.

Connection Settings (General Communication Settings)

Maximum Baud
Rate

Select the baud rate for serial communication.

Timeout

Select the communication timeout.

NOTE: Select a larger timeout for GPRS and installed modem communication configuration
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If communications are successful, the message line should show “USB (COM8)” for this example, and an (R)
should follow the Target number.

USB (\\COM32) User: NONE X5 - CsCAN Model Equal Equal Local:253 Target:253(R) [no forces] MOD

When connected directly to the controller to which
Cscape communications are required, the Local ID
and the Target ID should match. Local ID and Target ID Match

If the controller is not communicating, you may need to set the target ID of the controller in Cscape or on the unit.
The Target ID allows directing communications to a particular unit when multiple units are connected via a CsCAN
network. Units without CsCAN network ports respond to any network ID and do not require the ID to be configured.

To check or change the ID on the X5/X5 Prime OCS, press the System Menu key. ﬂ

The firstitem in the menu is Set Networks. Pressing Enter allows you to view or modify the ID of the unit.

Set Metworks

View Status

View Diags

UView Battery Status T and 4 Keys
Uiew I/0 Slots

View Protocols

set Fkeys Mode

Set Serial Ports

Set Time/Date

Set Beeper

Set Screen

Removable Hedia

Fail-Safe System

Clone Unit Enter Key

To point Cscape at the correct controller, change the Target ID using the Controller > Set Target Network ID dia-
log.
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Communicating via MJ1 Serial Port

Start by configuring Cscape to use the correct communications port. This can be done using the Tools - Options >
Communication Port dialog in Cscape.

Next, connect the PC’s serial port to the port labeled MJ1 on the X5/ X5 PRIME.

If communications are successful, the target indicator should show the mode of the controller Target: yy® as shown
in the status section above.

If the controller is not communicating, you may need to set the target ID of the controller in Cscape or on the unit.
The Target ID allows directing communications to a particular unit when multiple units are connected via a CsCAN
network. Units without CsCAN network ports respond to any network ID and do not require the ID to be configured.
To check or change the ID on the X5/ X5 PRIME OCS, press in the far upper right corner of the touch screen to
bring out the function keys, then press the System Menu key.

Select Set Networks and press Enter.
Select CAN ID: and press Enter allows you to view or modify the ID of the unit.

To point Cscape at the correct controller, change the Target ID using the Controller > Set Target Network ID dia-
log.
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Communicating via On Board Ethernet Port

The X5/ X5 PRIME Ethernet address may be set from the System Menu depending on the program currently
loaded.

To check or change the Ethernet address on the OCS, press in the far upper right corner of the touch screen to
bring out the function keys, then press the System Menu key.

Select Set Networks and press Enter.

At a bare minimum, the IP (IP Address) and NetM (NetMask) settings must be configured in order to communicate
via Ethernet. Depending on how the network is setup, the GatWy (Gateway) may also need to be configured.

From the factory, the X5/ X5 PRIME OCS is set to the IP Address 192.168.254.128. To obtain Ethernet com-
munications between Cscape and the OCS using a single Ethernet cable between a PC and the OCS, or through
an unmanaged Ethernet Switch, the PC will also need to be manually configured as follows (may require Admin-
istrator access on PC):

1. Access the Network Connections in the Control Panel (Shortcut: Press the Windows key and type Network
Connections... select the resulting filtered link).

2. Double-click the connection being used to directly connect to the X5/ X5 PRIME OCS to bring up the Con-
nection Status.

3. Click Properties.
4. Double-click Internet Protocol Version 4 (TCP/Ipv4) in the list of available protocols.
5. The PC may normally be set to “Obtain an IP address automatically”. Click next to Use the following IP
address:
6. Use the IP address 192.168.254.111 or something other than that of the OCS.
7. The Subnet Mask (255.255.255.0) should fill in automatically once the IP address has been entered.
8. The Default Gateway is not required for a direct connection.
9. Click OK all the way back to the Network Connections dialog.
10. Confirm the X5/ X5 PRIME OCS is set to the default 192.168.254.128 address or something on the same

network.
11. In Cscape, click Tools > Application Settings > Communications > Configure.
12. Select Ethernet, then enter the IP address of the X5/ X5 PRIME OCS.

IMPORTANT: The MTU setting defaults to the maximum 1500. It needs to match the PC’s MTU setting for
the best results. A PC may be set to an MTU of 1300 or something other than the default maximum setting by
a network administrator.

13. The Port for CsCAN over Ethernet is 18501.

14. The Mode for any controller with built-in Ethernet is Built-in/ETN Ethernet Mode.

15. Change the Timeout value to 3000 for direct connections. Timeout values of 5000-30000+ may be common
for access over the internet or via VPN or other more complex networks.

16. Click OK all the way back to the main Cscape window. It may take a moment to initialize the com-
munications.

17. Check the status bar for successful communications.

ETN:192.168.254.128 User: NOMNE X5 - CsCAN Model Equal Equal Local:253 Target:253(R) [no forces] MOD
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Examples of the PC Ethernet setup and the Cscape Ethernet setup mentioned in the above steps:

Internet Protocol Screenshot:

Internet Protocol Version 4

D/IPv4) Pr

General

You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
@ Use the following IP address:

IP address: 192 . 168 . 254 . 111

Subnet mask:

255.255.255. 0

Default gateway:

Obtain DNS server address automatically
@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[] validate settings upon exit

Cscape Ethernet Settings:

Target Marne: IDeIauItl

" Com Pout:

% Ethernet

" use

— Connection Medumn

" CanInterface:

" Installed Modem |

4

| 192 168 . 254 128

MTU Size  |1300

[canson

Phone Mumber |

[Eontoller USE COM Part [COM32) |

Mode: [Buitin/ETN Ethermet Mode |

— Connected Device

' Connected Device

 TagetModed [T —

W aximum Baud Ral

— Connection Settings

te: |‘I152DE| x

Timeout: I:!JDD ms
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Communicating via Cscape

To configure the Ethernet settings of the X5/ X5 PRIME OCS using Cscape, go to Controller > Hardware Con-
figuration. If not already done, select the correct connected controller, or use the Auto Config button to auto-
matically recognize a controller that is already successfully connected to Cscape.

Below the main controller configuration, under Network Ports, find LAN1, and click on the Config button to the
right of the greyed-out ETN300.

In the LAN1 Configuration, fill in the network setup for the X5/ X5 PRIME OCS. It may be required to consult IT per-
sonnel to determine proper settings if connection to a corporate network is required.

LAN1 Cenfiguration X |
Reqgister Usage
[ Use DHCP
Default Settings Register Get settings
IP Address: | 192 168 . 254 . 128 Namc:‘ ﬂ - |Gor|liqurmmn | [ Use CANID for last Octet
NetMask: | 255 = 255 . 255 . 0 Name: | ~] ™ [configuration ~ |
Gateway: [ o . 0 . 0 . 0 Name: | ] ™ [Configuration ~]
DNS Server: 0 0 0 .0 Name: | ﬂ ®  [configuration ~]
Status: Nama: ‘ ﬂ ..... |
Version: Name: | =l |

Protocol Support

Resident Protocols

(Ethernet Global Data)

[]SRTP Slave (90-30 Service Request)

[[IModbus Slave

[ Ethernet/IP

[]FTP {File Server)

[TTHTTP (Web Server)

[C1ASCI Over TCP/IP

E NTP Protocol{Obtain dock from web based server)

Downloadable Protocols

ETNIA |- None — ~| | |

None :l | |

oK Cancel

If Get settings from is set to Configuration for any parameter, the addresses in the Default Settings column will
take place when this program is loaded and every time this controller enters RUN mode. Registers may optionally
be defined that will reflect the settings. These settings may temporarily be changed via the SYSTEM menu but will
revert to the Cscape-configured settings at any transition into RUN mode, i.e. a program download or at power-up.

If Get settings from is set to Register for any parameter, the addresses in the Default Settings column are.

ignored entirely. The addresses instead must come from the configured registers. It is not possible to change these
settings via the SYSTEM menu in this case.
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Cscape Configuration

An overview of configuration:

1.
2.

3.

Start the configuration by selecting the Controller > Hardware Configuration menu item.

If the X5/X5 Prime OCS is connected to the PC, press the Auto Config System button to automatically
detect the Base model, /O, and any communication options.

If the X5/X5 Prime OCS is not connected, press the Config button to the right of the top of the unit. This
allows the base CPU to be selected.

Select either X5/X5 Prime OCS CsCAN from the type drop down box.

Once the type of X5/X5 Prime OCS is selected, the model # drop down box will provide the X5/X5 Prime
OCS model numbers from which to choose.

Once the X5/X5 Prime OCS CPU is selected, press OK to exit the dialog and configure the I/O that is present
in the first slot.

The 1/O configure dialog (specifically the Module Setup tab) provides four (4) buttons to configure all of the
I/0O. Go through each area of I/0 and configure it.

Once done configuring the I/O, OK out of configuration dialogs.

Configuring the X5/X5 Prime OCS 1/O has four main portions that are covered in this chapter. For additional inform-
ation on /O, refer to "General I/0 Configuration" on page 1 or "High Speed I/O (HSC / PWM) " on page 82.
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General I/0 Configuration

OV BIVIBW .. A
Digital INPUS 7
Digital/lPWM Output Configuration ... ... . . . 74
ANalOg INPULS . 76

Overview

The X5/ X5 PRIME OCS is a compact unit that contains four (4) digital inputs, four (4) solid-state digital outputs,
and four (4) analog inputs. Using the 1/O properly requires wiring to the proper terminals and configuring Cscape
properly. This section will offer some tips and suggestions to configure the 1/O properly. For the register mapping of
the I/O, see the Registers and Cscape Configuration chapters for more details.

Digital Inputs
NOTE: The digital inputs on the X5/ X5 PRIME OCS are designed for low voltage DC inputs.

The inputs are designed to support both positive and negative input modes. The mode is set by a configuration para-
meter in Cscape. All the inputs on the unit must be configured to the same mode.

Positive Logic vs. Negative Logic Wiring
The X5 OCS can be wired for Positive Logic inputs or Negative Logic inputs.

i g

Lov | ov

Co1 LECS

+ 1l
12-24vDC ()

Pesitive Logic In Negative Logic In

In positive logic mode a positive voltage applied to the input will turn the input. The internal design of this mode is
basically a resistor from the input to /0O ground. This mode is sometimes called sourcing.

In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input on. The internal design
of this mode is basically a resistor from the input to the positive 1/0 voltage (usually 12 or 24V). This mode is some-
times called sinking.

Some of the digital inputs may support high-speed input functional such as counting or frequency measurement.
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Digital Input Configuration

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod-
ule Setup > Digital InN/HSC

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selec-
ted. Then select the Local /0 tab.

! L S o o E E & u L L % L n u a B a s = T u M w

7 Hardware Configuration

7 Controller | Local 0| CANT (CSCAN) 110 | LANT 110 |

1 Series XL OCS Series - Description:
1 Touch screen Operator Control Station with
Device Type [X5 ~] fixed /O
] Model#  [HEXS ~| [ Properties
1 Display Ty 272 by 480 LCD
| Network Ports pay type |
Keypad Type: Touch + 4 F keys

1 CANT [CsCAN ~| Config ypad Type: | 5
1 Program Memory: |2048 K Bytes

cav2[ <] g v |
] Network Type:  [CSCAN
1 LAN1 [ETN300 Config

‘Advanced Ladder Functions

LAN2 Supports Analog Data

Real Time Clock Support
Serial Ports Config

Supports Retentive Data
OCS Wi-Fi Module Config

Auto Config
OK Cancel ‘ | Help

After selecting Local I/O, select the Config button next to the I/O connector.

Controller  Local 10 | CAN1 (CsCAN) 1O |

Module Configuration

oM Mo Sep IR
. Config

Digtal In / HSC Digital Out / PWM
Analog In Analog Out
oK Cancel
E
oK Cancel

The Module Configuration screen will appear, select the Module Setup tab. See below.

The Module Setup allows a user to configure four types of /0. NOTE: Not all controllers offer all four types. Refer to
the controller's datasheet on the using Horner's Documentation Search page.
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Select Digital In/HSC to open the Digital / HSC Input configuration dialog for a specific controller.

Digital / HSC Input Configuration X F

Digital inputs active mode Counter Modes
@® ? Counter mode Note: 2 Channel Supports:
1) 2-HSC

@ Positive Logic Note: This setting must 4 Counter mode
match that of the jumpers. i ) 2-Quadrature

" Negative Logic on the product ¢ 3) 2-Stepper Outputs

HSC IO Mapping

Starting Digital In: FME  Name: ~| - xn
Starting Analog In: [5eal005 Name: | ~] e %0
Starting Digital ot [%G0017 Name: | hd - .y
Starting Analog Out:  [%AQ001 Name: =] == x12

HSC WO Filtering

Filter Frequency L 1 J KHz

Number of Samples | 1

Counterl | Counter2

Type: |Disabled hd
Inputl Input2
Mode |
Disable Function: » Polarity: |
Latch Function: | > Polarity: |
Preload Function: > Polarity: |
Clear Function: > Polarity: |
Marker: > Polarity: |
Match: fd |
0K Cancel |

The Digital / HSC Input configuration allows the multi-mode digital inputs to be configured as either standard digital
inputs or as high-speed inputs.

The digital inputs active mode configuration allows the user to select if inputs are active high (Positive logic,
voltage triggers input high) or active low (Negative logic, OV triggers input high). For the X5/ X5 PRIME controller,
there are no jumpers to set.

The Counter Modes configuration allows the inputs to be configured as high-speed counter inputs. Two modes are
available, each with a unique set of functions that are allowed.

Mode High Speed Counters Quadrature Stepper Outputs
2 Counter Mode 2 1 2
4 Counter Mode 4 0 1

By default, 2 Counter Mode is selected but Counter1 and Counter2 are both disabled. This allows all digital inputs to
function as standard digital inputs addressed at %I1 - %l4.

The HSC I/0O Mapping section allows specification of register usage for high-speed counter functions. The register
specified is the first of multiple consecutive registers used. The type of register and the number of registers used is
noted to the right of each starting address configuration.

The Counter1 and Counter2 (and, if configured for four (4) Counter modes, Counter3 and Counter4) tabs allow

configuration of each of the high-speed counters. See the High Speed I/O chapter for more details on configuring
the high-speed counter inputs.
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Digital/PWM Output Configuration

al Qz

@ Normal @® Mormnal I
 PAWM#1 P &2

7 HSCT Output (" HSC2 Output

Output O J ‘Oulpu(ON J

(" Stepper (" Stepper

Starting Analog Out: |°/DAQ42] ‘ J <<<<<< %20
Starting Digital In |%HEW7 ‘ J -
Py State on Controller Stop

Py #1 Duty Cycle default ’ui —
P #2 Duty Cycle default ,07 —
P #1 Frequency ,07 —
Pk #2 Frequency. ,07 B
QOutput State on Controller Stop
1 2 3 4 5 [ 7 &
djajajajajajala]

1 i 12

a(3(3]3]

Legend

ﬂ =0FF E = 0N ! =Hold Last State

oK ‘ Cancel ‘

The Digital / PWM Output Configuration allows multi-mode digital outputs Q1 and Q2 to be configured as Normal
solid-state digital outputs, Pulse-Width Modulation (PWM) outputs, outputs that are triggered by High Speed
Counter functions, or Stepper outputs.

By default, both Q1 and Q2 are configured as Normal. This allows the application code to use them as digital out-
puts assigned to %Q1 and %Q2.

Setting Q1 to PWM #1 and/or Q2 to PWM #2 allows those outputs to function as a Pulse Width Modulation output.
Duty Cycle and Frequency are configured via registers assigned next to the Q1 and Q2 configuration boxes. See
the High Speed 1/0O Chapter for more details on configuring PWM outputs.

The PWM State On Controller Stop box contains items that allow the user to specify how the PWM outputs
behave when the controller is stopped. These items can either hold their value or default to some value when the
controller is stopped.

NOTE: The PWM outputs are set to the OFF state at power-up and during program download, and they remain in
that state until the unit is placed in RUN.

The Output State On Controller Stop box contains items to allow the user to specify how Normal digital outputs

behave when the controller is stopped. These items can either hold their value or default to some value when the
controller is stopped.
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Solid State Digital Outputs

Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and other low voltage
and low current devices.

NOTE: The digital outputs used on the X5/X5 Prime controllers are "sourcing" outputs. This means the out-
put applies a positive voltage to the output pin when turned ON. When turned off, the output applies approximately
zero volts with respect to the I/O ground. Use the Documentation Page to view the datasheet for a specific controller
for specifics on a module's I/0.

% Q1 a1
Q2

1@ a3 o

i@ o4 Q3

1@ vext Q4

i@ ov D Vext

OUTPUT CONNECTOR 10 -30vbe ov

The digital outputs used in the OCS have electronic short circuit protection and current limiting. While these elec-
tronic protections work in most applications, some application may require external fusing on these outputs.

The digital outputs in the OCS are typically controlled via %Q bits in the register mapping. Some of the outputs are
designed for high-speed applications and can be used for PWM or frequency output applications.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they
were in before the controller stopped or they can go to a predetermined state. By default, digital outputs turn off.
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Analog Inputs

The analog inputs on the OCS allow voltage or current measurement from a variety of devices. The voltage or cur-
rent mode is set though jumpers on the unit and settings in Cscape. Each channel can be separately configured for
voltage or current mode.

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some
installations. The downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual
input.

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod-
ule Setup > Analog In

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selec-
ted. Then select the Local /0 tab.

! L S o o E E & u L L % L n u a B a s = T u M w

7 Hardware Configuration X

7 Controller | Local 0| CANT (CSCAN) 110 | LANT 110 |

Series XL OCS Series = Description:
'Touch screen Operator Control Station with
Device Type [X5 ~] fixed /O
Model#  |HEXS | [ Properties
| Display T 1272 by 480 LCD
1 Network Ports R |
Keypad Type: Touch + 4 F keys
1 CAN1 |CsCAN - Config s | y
1 Program Memory: |2048 K Bytes
CAN2 = e |
1 Network Type: |CSCAN
| LAN1 [ETN300 Config
‘Advanced Ladder Functions
LAN2 Supports Analog Data
Real Time Clock Support
Supports Retentive Data
Serial Ports Config
OCS Wi-Fi Module Config

Auto Config
OK Cancel ‘ | Help

After selecting Local I/O, select the Config button next to the I/O connector.
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Controller Local /O | CANT (CSCAN) /0 | CAN2 (CSCAN) /0 | LANT O | LAN2 1/0 |

XLPlus - CsCAN )
0 0

XLI/O type 2

Config
Empty m EMPTY ﬂl Config

OK | Cancel

The Module Configuration screen will appear, select the Module Setup tab. See below.

(

I/0 Map Module Setup
|
Digital In/HSC Digital Out / PWM
Analog In Analog Out
OK Cancel Help

The Module Setup allows a user to configure four types of /0. NOTE: Not all controllers offer all four types. Refer to
the controller's datasheet on the Horner website's Documentation Page for more information regarding specific
models.
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Select Analog In to open the Analog Input Configuration dialogue:

Analog Input Configuration ped
Channel 1: Filter Constant:
Disable B2 ==
Channel 2:

Disable B ==
Channel 3:
Disable | =
Channel 4:
Disable RalE =
Channel 5:
Disable B ==
Channel b:
Disable | =

(0] | Cancel

The Channel x drop down windows allow the user to specify the mode for each analog input to operate. The Chan-
nel x drop down windows are enabled/disabled according to which model is being configured. All of the models
have the following modes available:

e 0.10V

¢ 0.20mA

e 4.20mA

For each range selected, the raw value in the corresponding register (%Al1 - %Al4) will be a range of 0 to 32000.
For example, Channel 1 set to 4--20mA would show a 0 in %Al1 for 4mA on the input, 32000 in %AlI1 for 20mA (and
-8000 in %Al1 for OmA).
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Analog Inputs Wiring

The analog inputs on the X5/ X5 PRIME OCS allow voltage or current measurement from a variety of devices. The
voltage or current mode is set though settings in Cscape. Each channel can be separately configured for voltage or
current mode.

[“ 20mA Analog In - Not Self Powered
% 20m 8+,
(Ir .
m Loop Power
An @Ik B
A2/ @k
A3 @I 20mA Analog In - Self Powered
Al4 @l 0-10VDC IN

ov .m 20mb -+
INPUT CONNECTOR . 0-10VDC ¢

—

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some
installations. The downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual
input.
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Scaling Analog Inputs & Examples

To access the Advanced Math Scaling function, select Home > View > Project Toolbox. This will open a side bar,
and then select Advanced Math > Scale.

Example 1

The Cscape Scale function, found in the Advanced Math functions, allows for very easy conversion of the raw input

value into a meaningful reading. For example, a pressure transducer may be specified as a 4-20mA signal to signify
a 0-2000 psi pressure reading. With the analog channel set to the 4..20mA range, the raw analog input value, which
is in INT format ranges from 0 to 4mA to 32000 for 20mA. Use the Scale function to obtain an Integer pressure read-

ing using the 0-32000 raw input range and the sensor’s 0-2000psi output range.

ALW_ON peake

% 1| Analog_[nput] o .

: 55007 0~ min
2 %1001 4IN1

320004 max

\ 0min | ps|_Reading
Qr%R00001
20004 maz

Example 2:

If readings with fractions are required, the raw Integer input value must first be translated in REAL, or Floating Point
Format, see note below. . The Cscape INT-to-REAL Conversion function may be used to convert the raw input
value from INT to REAL format in an intermediate memory location. The SCALE function, specified as REAL type,
may be used to scale the converted raw value into a reading that supports digits beyond the decimal place, i.e.

475.25psi.

4
AL DN

Int

®— I l

2 #5007
5

Real
Analog_lnputi
%A1001HIN1

Scale

Analog_lnputl

Analogvl nﬁuﬂ %E
-%R00003 %R

32000

2000+

"BEaL

DOJ3—IN1

7 min b

Q

teading_REAL
-%R 00005
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High Speed I/O (HSC / PWM)

OV IV W 82
High Speed 110 GloSSary ... ... 83
High Speed Counter (HSC) Functions ... ... 84
HSC FUunctions ... .. ... 89
HSC Functions Register Maps ... 91
High Speed Output Functions ... .. . 95
High Speed Output Functions Register Map ............................................................................ 98
HSC WO Filtering . ... . 101
Overview

In addition to the compliment of simple analog and digital I/O, several of the OCS I/O modules support High Speed
Counting (HSC) I/O functions and may also support Pulse Width Modulation (PWM) Output functions (non-relay
modules). The HSC functions include internal timing, frequency, totalizing, pulse width/period, and quadrature
measurement. The PWM functions include traditional PWM (with variable rate and duty cycle) and a stepper (lim-
ited functionality) with variable acceleration and deceleration rates.

The OCS contains a Field-Programmable Gate Array (FPGA), which is an integrated configurable circuit that
allows the OCS to be programmed to have either two high-speed counters or four high-speed counters. The OCS
ships with two high-speed counters, but a customer can contact Horner Technical Support to receive a file that will
configure the unit to have four. These modes are not supported simultaneously. Two counter mode supports Quad-
rature mode and two stepper outputs, while four counter mode does not support Quadrature mode and supports
only one stepper output.

This chapter describes the operation of these high level I/O functions. For configuration details of these functions,
see"Cscape Configuration" on page 1.
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High Speed I/O Glossary

Glossary of High Speed I/O Terms

Accumulator

Register used to accumulate or store up a sum or count of many items or events.

A special function to zero out the value in a specific register. (Not used with Frequency or Period

Clear Measurement.)
Disable A special function to prevent the counter from running.
Encoder A sensor or transducer for converting rotary motion or position to a series of electronic pulses

An integrated, configurable circuit that allows the controller to be programmed to have either two
FPGA . .

high-speed counters or four high-speed counters.
Frequency The number of times an electromagnetic signal repeats an identical cycle in a unit of time, usually
Input one second.

Latch (strobe)

A special function that uses a digital logic circuit to store one or more bits. A latch has a data

input, a clock input and an output. When the clock input is active, data on the input is "latched" or
stored and transferred to the output register either immediately or when the clock input goes inact
ive. The output retains its value until the clock goes active again.

Marker

Input into the OCS that indicates a particular position. Typically, an encoder has a marker output
that represents a specific point in the rotation.

Polarity

A Polarity pull-down box is associated with each function and indicates the manner in which the
trigger happens (e.g., High level, Low Level, Falling Edge, Rising Edge).

Preload (load)

A special function used to trigger loading of a value into a register upon an event. (Not used with
Frequency or Period Measurement.)

A high-speed device that expresses the phase relationship between two periodic quantities of the

Quadrature | same period when the phase difference between them is one fourth of a period. A couplerin
which the two output signals are 90° out of phase.
Totalizer A counter that sums the total number of cycles applied to its input.
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High Speed Counter (HSC) Functions

The supports two high speed, configurable counters. There are four dedicated inputs that can be configured to a
number of different options. Each of the two counters can run in one of five modes. Those modes are Totalizer, Fre-
quency Counter, Pulse Width Measurement, Period Measurement and Quadrature measurement. For some
modes, more than one HSC input may be consumed. The measurement values are provided to ladder in a %Al
register. Refer to the System Register chapter for more details.

Frequency
In frequency mode, the frequency of the input signal is written to the accumulator in terms of Hertz (cycles/second).
When using frequency mode, four update selections are provided which specify the width of the sample window.

NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) but lowers the fre-
quency accuracy (resolution) and increases the minimum frequency measurement limit. In this mode the Disable
and Latch special functions are allowed. Refer to the "High Speed I/O Glossary " on the previous pagey for a
description of these functions.

Totalize

In totalize mode, the accumulator is simply incremented or decremented each time the input transitions in a specific
direction.

The totalizer supports the following modes:

This mode ties the input to the counter to an internal 10MHz or 1MHz clock. The special func-

Internal . .
tions can be used to accurately time events.

This increments the accumulator when the input is enabled.

EEE NOTE: Two inputs can be assigned. Either input can cause the counter to increment. The

second input can also be disabled.

This decrements the accumulator when the input is enabled.

(i e NOTE: Two inputs can be assigned. Either input can cause the counter to decrement. The

second input can also be disabled.

::r?;/)?l‘t)‘flw:lplln- In this mode, Input 1 (assigned to any of the four inputs) increments the counter, while Input 2
(also assigned to any of the 4 inputs) decrements the counter.

put 2 Down)

Clk/Dir This mode uses input 1 as a clock signal to increment or decrement the counter and then uses

(Input 1 Clk, input 2 to decide the direction. Input 2 disabled increments the counter, while input 2 enabled

Input 2 Dir) decrements the counter.

NOTE: The totalize mode enables the Disable, Latch, Preload, and Clear special functions. Refer to the "High
Speed I/0O Glossary " on the previous page for a description of these functions.

NOTE: Counter triggers off the rising edge of the signal.

A

Y

Rising Edge Signal Falling Edge Signal

Three different options are available to reset the current count:
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a. Configured reset value - When configuring the Totalize function, a value may be specified under the Counts
per Rev column. When the totalizer accumulator reaches this value - 1, the accumulator will reset to zero on
the next count. Specifying zero for this value allows the totalizer to count through the full 32-bit range before
resetting.

b. Ladder Control - Setting registers %Q17-20 reset HSC1-4 (respectively) with no additional configuration.
When these registers are asserted, the associated totalizer accumulator is reset and held at zero (level sens-
itive).

c. Directdigital input control (HSC1 and HSC2 only) - HSC3 (%I111) and HSC4 (%I12) may be configured as
hardware digital reset signals for HSC1 and HSC2 (respectively). To enable these inputs as reset signals,
specify the type as Totalize Reset (NOTE: The corresponding Totalize HSC must be previously configured
before this option is available). The direct digital reset controls are edge sensitive with the edge polarity con-
figurable.

Maximum direct digital reset latency is 100pus.

The totalize function also supports an option which compares the current accumulator value with a supplied Preset
Value (PV), which is provided through a %AQ, and drives a physical digital output based on the that comparison.

NOTE: This option (available for HSC1 and HSC2 only) drives Q1 or Q2 output point (respectively) once the asso-
ciated totalizer accumulator reaches (or exceeds) the PV value. To enable this function, the corresponding PWM
function output (Q1 or Q2) must be configured for HSCx Output.

NOTE: Q1 and Q2 are PWM function outputs that may be configured independently as one of the following: stand-
ard digital output, PWM, HSCx or stepper output.

Preset values may be modified during run-time. A preset value of zero disables (resets) the totalizer compares func-
tion output causing the output to remain low.
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Pulse Width Measurement

In pulse width measurement mode, the high-speed input can measure the width of a pulse stream in one of two
modes and provides a continuous indication of the last sampled value. In this mode the Disable and Latch special
functions are allowed. Refer to the "High Speed I/O Glossary " on page 83 for a description of these functions.

Width High 1 ps Counts — In this sub-mode the accumulator value will contain the number of 1 us counts the pulse
is high.

Width High

Width Low 1 ps Counts - In this sub-mode the accumulator value will contain the number of 1 us counts the pulse
is low.

Width Low
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Period Measurement

In period measurement mode, the high-speed input can measure the period of a pulse stream in one of two modes
and provides a continuous indication of the last sampled value. In this mode, the Disable and Latch special func-
tions are allowed. Refer to the "High Speed I/O Glossary " on page 83 for a description of these functions.

Period Rising Edges 1 us Counts — In this sub-mode the period of the input signal is reported in one (1) ys units.
The period measurement will start on the rising edge of the input.

Period from Rising Edge

Period Falling Edges 1 us Counts — In this sub-mode the period of the input signal is reported in 1 ps units. The
period measurement will start on the falling edge of the input.

Period from Falling Edge
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Quadrature

Quadrature mode uses two HSC inputs, any of the four HSC inputs can be assigned for this purpose.

Quadrature mode works much like the totalizer except the accumulator will automatically increment or decrement
based on the rotation phase of the two inputs. See the following example for more details. Quadrature inputs are typ-
ically used for reporting the value of an encoder.

Two modes are available for quadrature that select whether the accumulator counts up or down when the phase of
Input 1 leads Input 2. Check your encoder’s documentation to determine the output form it uses or try both modes to
determine if the encoder counts up when expected.

J [ 1 (leading)
| L2 (lagging)
90°

phase «
shift

Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count up,” the accumulator
will count up when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is falling and 2 is high, and when 1 is low and 2
is falling. This results in 4 counts per revolution. So in order to determine the number of cycles, the accumulator
would have to be divided by 4.

Marker reset operation is configured in the special operations and can be assigned to any of the 4 high speed inputs
or can be assigned to be controlled by a “Q” bit in ladder.

NOTE: The quadrature mode enables the Disable, Latch, Preload, Clear and Marker special functions. Refer to the
"High Speed I/0 Glossary " on page 83 for a description of these functions.
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Register Match

Totalizer & Quadrature counter modes support a register match function. When the accumulator value matches
either the Match 1 or Match 2 value configured in the corresponding %AQ registers, a high-speed output can Turn
On, Turn Off, or Toggle. An internal %l register mirrors the output state whether the high-speed output is configured
or not. The output can be reset in program logic using the corresponding %Q registers.

1
2.
3

. 2-Counter Mode has Register Match support for both counters.

4-Counter Mode has Register Match support only for counters 1 and 2.

. The High-Speed Outputs are %Q1 for Counter 1 and %Q2 for Counter 2. They operate as high-speed out-

puts, independent of the controller scan rate, when configured as ‘HSC Output’ in the Digital Out/PWM con-
figuration in Cscape.

The High-Speed Output state reflects in the status register “High Speed Out”, e.g. %11603 for Counter 1 (the
update speed of the status bit is scan rate dependent)

The High-Speed Output can be reset through ladder with the assigned output, e.g. %Q1606 for Counter 1
Both Match 1 and Match 2 values will trigger the match function.

If the output is already triggered by any Match register while using ‘Turn On’ or ‘Turn Off modes, subsequent
matches will not affect the output.

If using ‘Toggle’ mode, every match of either Match value will toggle the output to the opposite state.

HSC Functions

The high-speed input on the OCS contains many optional tasks. All of which can be disabled, or set to an internal
pre-assigned register (Assigned %Q) or to one of the external high speed inputs (External Input#1, 2, 3, or 4), or
they can be set as an “overflow interrupt” or “underflow interrupt” meaning that they will occur when either the Over-
flow or Underflow input has been activated.

Disable: When the Disable function is active, it will “disable” the high-speed inputs and no longer count
pulses until it is re-enabled

Latch: When the Latch function is active, it takes the current value of the Accumulator and moves it into the
“Latch Value” register

Preload: When the pre-load function is active, it will take the value from the “Preload” register and put it into
the “Accumulator” for the corresponding Counter.

Clear: When the clear function is active, it will move a value of 0 into the “Accumulator” for the corresponding
counter.

Marker: When the marker function is enabled, it acts as a dynamic enable/disable for the Disable, Latch, Pre-
load, and Clear functions. If the marker is enabled and “Assigned %Q” is selected, then both the “Disable”
and the “Disable Marker” bits need to be set high in order to disable the high-speed input. If the Marker is set
for one of the inputs, then the input will need to be “High” in order to use any of the Disable, Clear, Preload, or
Latch functions.
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Status Bits

There are three status bits (%l registers for each high-speed counter):

= Overflow Flag: This status bit turns high when the Accumulator “overflows”, it moves from 4,294,967,295 (-
1 if Signed) to 0, this bit can be reset with the “Output Reset Bit”. See Table 9.4.

= Underflow Flag: This status bit turns high when the Accumulator “underflows”, it moves from 0 to
4,294,967,295 (-1 if Signed), this bit can also be reset with the “Output Reset Bit”.

NOTE: For the Overflow and Underflow flag registers, if using some sort of counter that counts both
up and down, going over the threshold to go negative, triggers the underflow, and then going back
over the threshold back into positive numbers will trigger the positive register to go active.

= High Speed Out: This register will follow the high-speed output assigned to the counter, it is important to
note that this register is still populated within the scan time so the value in this register may not be up to date
depending on the timing of the output (it should be up to date within one scan).
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HSC Functions Register Maps

The register assignments for the high-speed I/O can be moved via a setting in Cscape. The values shown are the
DEFAULT values and may not match the same starting point as the values shown below.

HSC Functions Register Map for 2 HSC Configuration

Register Frequency | Pulse | Totalize Quad
%AIl401-402 Accumulator - Counter 1
%AI1403-404 Latch Value — Counter 1
%Al405-406 Accumulator — Counter 2
%AI1407-408 Latch Value — Counter 2
%AQ401-402 | | Preload — Counter 1
%AQ403-404 Match1 — Counter 1
%AQ405-406 Match2 — Counter 1
%AQ407-408 | | Preload — Counter 2
%AQ409-410 Match1 — Counter 2
%AQ411-412 Match2 — Counter 2
%AQ413-424 Reserved
%Q1601 Latch — Counter 1
%Q1602 Preload — Counter 1
%Q1603 Clear — Counter 1
%Q1604 Disable — Counter 1
%Q1605 Direction—C 1
%Q1606 Output Reset — Counter 1
%Q1607 Preload Disable — Counter 1
%Q1608 Latch Disable — Counter 1
%Q1609 Disable Marker — C1
%Q1610 Latch Marker — C1
%Q1611 Preload Marker — C1
%Q1612 Clear Marker — C1
%Q1613-1616 Reserved
%Q1617 Latch — Counter 2
%Q1618 Preload — Counter 2
%Q1619 Clear — Counter 2
%Q1620 Disable — Counter 2
%Q1621 Direction—C2
%Q1622 Output Reset — Counter 2
%Q1623 Preload Disable — Counter 2
%Q1624 Latch Disable — Counter 2
%Q1625 Disable Marker — C2
%Q1626 Latch Marker — C2
% Q1627 Preload Marker — C2
%Q1628 Clear Marker — C2
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%I11601 Overflow Flag — Counter 1
%I11602 Underflow Flag — Counter 1
%I11603 High Speed Out 1
%11604 Reserved

%11605 Overflow Flag — Counter 2
%I11606 Underflow Flag — Counter 2
%I11607 High Speed Out 2
%I11608 Reserved
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HSC Functions Register Map for 4 HSC Configuration

NOTE: Four Count Mode requires FPGA update. See "Overview" on page 82.

Register

Frequency

Pulse

Totalize

%AI1401-402

Accumulator - Counter 1

%AIl403-404

Latch Value — Counter 1

%AIl405-406

Accumulator — Counter 2

%AI1407-408

Latch Value — Counter 2

%AIl409-410

Accumulator — Counter 3

%AI1411-412

Latch Value — Counter 3

%AI1413-414

Accumulator — Counter 4

%AIl415-416

Latch Value — Counter 4

%AQ401-402

Preload — Counter 1

%AQ403-404

Match1 — Counter 1

%AQ405-406

Match2 — Counter 1

%AQ407-408

Preload — Counter 2

%AQ409-410

Match1 — Counter 2

%AQ411-412

Match2 — Counter 2

%AQ413-414

Preload — Counter 3

%AQ415-416

Match1 — Counter 3

%AQ417-418

Match2 — Counter 3

%AQ419-420

Preload — Counter 4

%AQ421-422

Match1 — Counter 4

%AQ421-424

Match2 — Counter 4

%Q1601 Latch — Counter 1

%Q1602 Preload — Counter 1

%Q1603 Clear— Counter 1

%Q1604 Disable — Counter 1

%Q1605 Direction — C1

%Q1606 Output Reset — Counter 1

%Q1607 Preload Disable — Counter 1

%Q1608 Latch Disable — Counter 1
%Q1609-1616 Reserved

%Q1617 Latch — Counter 2

%Q1618 Preload — Counter 2

%Q1619 Clear — Counter 2

%Q1620 Disable — Counter 2

%Q1621 Direction—-C2

%Q1622 Output Reset — Counter 2

%Q1623 Preload Disable — Counter 2

%Q1624 Latch Disable — Counter 2

%Q1625-1632

Reserved
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%Q1633 Latch — Counter 3

%Q1634 Preload — Counter 3

%Q1635 Clear — Counter 3

%Q1636 Disable — Counter 3

%Q1637 Direction — C3

%Q1638 Output Reset — Counter 3

%Q1639 Preload Disable — Counter 3

%Q1640 Latch Disable — Counter 3
%Q1641-1648 Reserved

%Q1649 Latch — Counter 4

%Q1650 Preload — Counter 4

%Q1651 Clear — Counter 4

%Q1652 Disable — Counter 4

%Q1653 Direction — C4

%Q1654 Output Reset — Counter 4

%Q1655 Preload Disable — Counter 4

%Q1656 Latch Disable — Counter 4
%Q1657-1664 Reserved

%I11601 Overflow Flag — Counter 1

%11602 Underflow Flag — Counter 1

%11603 High Speed Out 1

%11604 Reserved

%11605 Overflow Flag — Counter 2

%11606 Underflow Flag — Counter 2

%11607 High Speed Out 2

%I11608 Reserved

%11609 Overflow flag — Counter 3

%11610 Underflow flag — Counter 3

%11611 High Speed Out 3

%1612 Reserved

%1613 Overflow flag — Counter 4

%1614 Underflow flag — Counter 4

%1615 High Speed Out 4

%I11616 Reserved
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High Speed Output Functions

On units that support high-speed output functions, two dedicated outputs are available that can be configured for
one of four modes of operation. Those modes are Normal, PWM, HSC Match and Stepper.

Normal
When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and %Q2 drives that
respective output.

PWM
When either Q1 or Q2 is configured for PWM, the PWM function drives that respective output. Both PWM channels
may be individually enabled and can have independent frequency and duty cycles.

The PWMs require two parameters (%AQs) to be set for operation. These parameters may be set at run-time.

Duty Cycle - The Duty Cycle is a 32-bit value from 0 to 32,000 indicating the relative duty cycle of the output. For
example, a value of 8000 would indicate a 25% duty cycle, a value of 16,000 would indicate a 50% duty cycle. Zero
(0) turns the output off, 32,000 turns the output on.

Duty Cycle

Frequency - The Frequency is a 32-bit value indicating the output frequency in Hertz. One over the frequency is the
period.

Period

At controller power-up or during a download, the PWM output is maintained at zero until both the Frequency and the
Duty cycle are loaded with non-zero values. When the controller is placed in stop mode, the state of the PWM out-
puts is dependent on the PWM State on Controller Stop configuration. This configuration allows for either hold-last-
state or specific frequency and duty cycle counts. Specifying zero for either the period or duty causes the PWM out-
put to remain low during stop mode.

NOTE: For standard I/O models (1E3, 1E4, 1E5, and 1E6) the maximum recommended PWM frequency is 10kHz,
due to the limitations of built-in output circuitry. The HE-XHSQ generates 24V pulse outputs with a recommended
max of 400kHz. The HE-XHSQ-5 generates 5V pulse outputs with a recommended max of 1.0MHz. The add-on
HSQ and HSQ-5 module can be added to the 1E2 unit for HSC function.

Page 95 0f 173


https://hornerautomation.com/wp-content/uploads/2014/12/MAN0962-01_SparkQuenchers_Datasheet_01.pdf

I.I HORNER

SR O UP High Speed I/O (HSC / PWM)

PWM Output Waveform

24 \olts

PWM OFF

20%
Rise Fall
Time Time
L R PWM Penod .............................. »

PWM Output Waveform Table
Rise Time 150ns Max
Fall Time 150ns Max
PWM Period | Frequency = 1/Period

High Speed Counter Match

When either Q1 or Q2 is configured for HSC Output operation, their output state is based on a comparison between
the counter accumulator and match registers. Refer to the "HSC Functions Register Maps" on page 91 for more

details.
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Stepper Function

The OCS supports two stepper functions, one on each high-speed output when in two counter mode. In four
counter mode, the OCS supports one stepper function

The Stepper requires five parameters (%AQs) to be set for operation. These parameters may be set at run-time but
are ‘latched’ when the stepper is commanded to start:

Start Fre-
quency
(pulses per
second)

Sets the frequency for the first cycle during the acceleration phase and the frequency of the last
cycle during the deceleration phase. When an acceleration or deceleration count is specified, the
Start Frequency must be greater than 0 and must not exceed the run frequency or an error is gen-
erated.

Run Fre-
quency
(pulses per
second)

Sets the frequency for the last cycle during the acceleration phase, the consistent frequency dur-
ing the run phase, and the frequency of the first cycle during the deceleration mode. The Run Fre-
quency must be greater than 0 and must not exceed 5000Hz (standard), 400,000Hz (HE-XHSQ)
or 1.0MHz (HE-XHSQ-5)

Acceleration
Count

Sets the number of cycles to occur within the acceleration phase. The frequency of the cycles
within this mode will vary linearly between the specified Start and Run frequency. The Accel count
must not equal 1 or an error is generated. Setting this value to zero disables this phase.

Run Count

Sets the number of cycles to occur within the run phase. The frequency of the cycles within this
mode is constant at the specified Run frequency. The Run count may be any value. Setting this
value to zero disables this phase.

Deceleration
Count

Sets the number of cycles to occur within the deceleration phase. The frequency of the cycles
within this phase will vary linearly between the specified Run and Stop frequency. The Decel
count must not equal 1 or an error is generated. Setting this value to zero disables this phase.

The stepper provides two Boolean registers to provide stepper status:

Ready/Done

A high indication on this register indicates the stepper sequence can be started (i.e. not currently
busy) and also when the move is completed.

Error

A high indication on this register indicates that one of the analog parameters specified above is
invalid or the stepper action was aborted before the operation was complete. This register is
cleared on the next start command if the error was corrected.

The stepper requires one discrete register to control the stepper action. Setting this register starts the stepper cycle.
This register must remain set to complete the entire cycle. Clearing this register before the cycle is complete aborts
the step sequence and sets the error bit.

NOTE: Setting the PLC mode to stop while the stepper is in operation causes the stepper output to immediately
drop to zero and the current stepper count to be lost.

NOTE: The stepper output level may cause damage or be incompatible with some motor drive inputs. Consult drive
documentation to determine if output level and type is compatible.
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High Speed Output Functions Register Map

The register assignments for the high speed I/O can be moved via a setting in Cscape. The values shown are the
DEFAULT values and may not match the same starting point as the values shown below.

PWM Functions Register Map, Two Counter

Register

PWM

Stepper

%AQ421-422

PWM 1 Duty Cycle (32-bit)

Start Frequency — Stepper 1

%AQ423-424

PWM 1 Frequency

Run Frequency — Stepper 1

%AQ425-426

%AQ427-428

%AQ429-430

Acceleration Count — Stepper 1

Run Count — Stepper 1

Deceleration Count — Stepper 1

%AQ431-432

PWM 2 Duty Cycle (32-bit)

Start Frequency — Stepper 2

%AQ433-434

PWM 2 Frequency

Run Frequency — Stepper 2

%AQ435-436

%AQ437-438

%AQ439-440

Acceleration Count — Stepper 2

Run Count — Stepper 2

Deceleration Count — Stepper 2

%Q1* Start Move Bit — Stepper 1

%Q2* Start Move Bit — Stepper 2
%1617 Ready/Done — Stepper 1
%I11618 Error — Stepper 1
%11619 Ready/Done — Stepper 2
%I11620 Error — Stepper 2

PWM Functions Register Map, Four Counter

Register PWM Stepper

%AQ451-452

PWM 1 Duty Cycle (32-bit)

Start Frequency — Stepper 1

%AQ453-454

PWM 1 Frequency

Run Frequency — Stepper 1

%AQ455-456

%AQ457-458

%AQ459-460

Acceleration Count — Stepper 1

Run Count — Stepper 1

Deceleration Count — Stepper 1

%AQ461-462

PWM 2 Duty Cycle (32-bit)

%AQ463-464

PWM 2 Duty Frequency

%AQ465-469 Reserved
%Q1* PWM1 Out Stepper On
%Q2* PWM2 Out
%11649 Stepper Ready/Done
%11650 Stepper Error

*Q30 and Q31 for model 2 using HSQ or HSQ-5 add-module (necessary to start move)
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Example 1

Duty Cycle

Frequency

To get a 50% Duty Cycle @ 10kHz waveform
on PWM1:

Set %AQ421-422 = 16,000

Set %AQ423-424 = 10,000

Example 2

Duty Cycle

Frequency

To get a 50% Duty Cycle on PW1 and
90 % Duty Cycle
on PWM2 @ 1kHz waveform:

Set %AQ421-422 = 16,000

Set %AQ431-432 = 28,800
(duty cycle (32000 * 0.9))

Set %AQ423-424 = 1,000

Set %AQ433-434 = 1,000

Example 3

Duty Cycle

Frequency

To turn PWM 1 output ON all the time

Set %AQ421-422 = 32,000

Set %AQ423-424 = Any Value

Example 4

Duty Cycle

Frequency

To turn PWM 1 output OFF all the time

Set %AQ421-422=0

Set %AQ423-424 = Any Value
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Example 1 S AT Accel Count Run Count Decel Count
Frequency Frequency
0, 4= 0, -A = 0, -8 =
10,000,000 steps| Set %AQ421 = | Set %AQ422 = Set %AQ423-4 = | Set %AQ425-6 = | Set %AQ427-8
control sequence | 2500 (Hz) 5000 (Hz) 1,000,000 8,000,000 1,0000,000
9 (Steps) (Steps) (Steps)

When the start bit is energized, the example starts at 2.5kHz and ramps up to 5kHz during the first 1,000,000
steps. Then, it runs at 5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

Example 2 SEI L Accel Count Run Count Decel Count
Frequency Frequency
0, A = 0, -6 = 0, -8 =
5,000,000 steps | Set %AQ421= | Set %AQ422 = Set %AQ423-4 = | Set %AQ425-6 = | Set %AQ427-8
control sequence | 500 (Hz) 1000 (Hz) 2,000,000 2,000,000 1,000,000
q (Steps) (Steps) (Steps)

When the start bit is energized, the example starts at 0.5 kHz and ramps up to 1 kHz during the first 2,000,000
steps. Then, it runs at 1 kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 steps it slows to a

stop.
Example 3 Sl AL Accel Count Run Count Decel Count
Frequency Frequency
0 -6 =
6,000,000 steps | Set %AQ421= | Set %AQ422= | Set %AQ423-4 = gztogggg 25-6 Set %AQ427-8 =
control sequence | 50 (Hz) 250 (Hz) 150,000 (Steps) (S,tepé) 350,000 (Steps)

stop.

When the start bit is energized, the following example starts at 50Hz and ramps up to 250Hz during the first
150,000 steps. Then, it runs at 250Hz for the next 5,500,000 steps. During the last 350,000 steps it slows to a

NOTE: Prior to the start of a move, the Ready/Done bit for that channel must be ON (%11617 or %11619 for channel
1 and 2 respectfully). The Ready/Done bit will turn OFF during the move, and then back ON once the move is com-

pleted.

NOTE: The pulse generation hardware on the OCS can generate any frequency that can be evenly divided into
10MHz (10,000,000HZz) under the maximum recommended frequencies for each model. This results in a very
smooth operation at lower frequencies, with a progressively choppier operation at higher frequencies, as the units
reach their maximum recommended frequency.
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HSC 1/O Filtering
This feature is used to enable digital Filter for HSC Inputs.

Selecting Digital In/HSC configuration opens up the following dialog where in HSC I/O Filtering is available.

Digital / H5C Input Configuration

Digital inputs active moda Counter Modes
(;" . .
@ Posive Logic 2 Counter mode  Nobe: 2lfihgnglcﬁmuuls.
i S, || € dconwree
e of the jumperz
e e I ) 2Stepper Dulpids
T
HSC 110 Mapping
Statng Digital In: [=17601 i « 8 Statting Digital Out: [07601 i « 32
Slaling AnglogIre [5a1401  eerr 58 Statling Andlog Out: [ZAD400 e 12
HSC /0 Filtering
(I ™ xno ™ =m I zn2
Filter Frequency )' 3142 3: EHz
1kHz 10MHz
Hurnbes of Samplcsg JI iE 3:
i...1......................................................................................................1n.:
Courter] | Courter2 |
T | Totakzer -
[ J Inpit] Irput
Mode [Intemal =] [Inteinal Clock 10MHz =] |
Disable Function: | Dizabled *| s Poluiity: |High lewel =
Latch Functior; | Disabled w| o Polaiily, |High leved =
Preload Functior: | Dizabled w | e Polaiity [High level o
Cleat Functior:  [Diizabled w | ey Polaity (High bevel -
Marker: I | ———— > Polaiity: =
Match  |Disable -
ok | cancal |

Input signal is filtered based on the filter frequency and Number of samples selected. User has to select Filter Fre-
quency and Number of samples based on the frequency of the Input signal.

Filter Frequency: To set the filter, choose a value that is: 4*Number of Samples*Expected Max Hz on the high-
speed inputs.

Number of samples: The input must be stable for this many samples before the HSC accumulator is affected by
any change.

The state (high or low) of the high-speed input is sampled with every rising input edge of the filter frequency. The
rising edges of the filter frequency are totaled in a sample counter, and when that total equals the number of
samples configured, the sample counter is reset. If the high-speed input state did not change by the time of the
sample counter reset, that state, high or low, is passed on to the high-speed accumulator. If the high-speed input
state changes during the sample counting, the sample counter is reset to zero and the process starts over.
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Figure 1: Input Signall

_
—
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Figure 2: Filter Frequency: Example IMHz

Number of samples: 4

If user selects filter frequency as TMHz and Number of samples as 4, then Input signal is sampled for 4 samples
and if the signal is stable for 4 samples i.e. 4ps then the signal is passed to Accumulator.

If the Input state is changed in between the sampling counts, then the count is reset, and the Input state is again
checked for given number of samples.

Refer to Dotted lines in the Figure 2, after 2 samples the state of input signal changes to 1, so the counter is again
started to count 4 samples, to pass the signal to accumulator.

There will be a delay in passing the input signal to accumulator since we are filtering the Input signal and the delay

is based on the selected filter frequency and Number of samples. In the above example filter frequency is TMHZ
(1us) and number of samples: 4, so the minimum delay in input signal will be 4us.

Figure 3: Input signal before filtering

Figure 4: Input signal after filtering

This delay will be 4ps.
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Serial Communications

The Serial Port & Dip Switches ... . .
RS-485 Serial Port
CAN Termination ...
Cscape Programming via Serial Port ...
Ladder-Controlled Serial Communication ... ...

All X5/X5 Prime OCS models provide two serial ports, which are implemented with single 8-pin modular RJ45 con-

nectors, are labeled MJ1 and MJ2. The MJ1 serial port is RS-232 while the MJ2 port is RS-485. MJ1 defaults to

OCS programming by connecting it to the COM port of a PC running Cscape. In addition, both MJ1 and MJ2 can be

used for application-specific communication, using a variety of standard data exchange protocols.

The Serial Port & Dip Switches

NOTE: If needed, wiring for MJ1/2 can easily be broken out into eight (8) separate screw terminals using the
HE200MJ2TRM adapter.

MJ1 PINS MJ2 PINS

PIN SIGNAL DIRECTION SIGNAL DIRECTION

@

8 TXD ouT

UL

1 7 RXD IN
[3) ov GROUND ov GROUND
+5V @ +S5V@
5 eoma OUT coma  OUT
A RIS out
3 CTS IN
2 - - RX-/TX- INJOUT
1 = - RX+/TX+ INfOUT
DIP SWITCHES
" PIN NAME FUNCTION  DEFAULT
RS-485 ON=

J Termination  Terminated 207

n > AN ON= OFF

Termination  Terminated

3 Bootload Always Off  OFF
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RS-485 Serial Port

RS-485 Termination - Proper RS-485 termination minimizes reflections and improves reliability. The 485 serial
port allows an internal RS-485 termination resistor to be placed across pins 1 and 2 by DIP Switch Setting. Only the
two devices physically located at the endpoints of the RS-485 network should be terminated.

RS-485 Biasing - RS-485 biasing passively asserts a line-idle state when no device is actively transmitting, which
is useful for multi-drop RS-485 networking. The 485 serial ports allow internal RS-485 bias resistors to be switched
in, pulling pin 1 up to 3.3V and pulling pin 2 down to ground. The Set Serial Ports item in the System Menu can be
used to enable RS-485 biasing. Also, an application graphics screen that writes to %SR164 can do the same thing.
Setting %SR164.1 enables MJ1 biasing and setting %SR164.2 enables MJ2 biasing.

If biasing is used, it should be enabled in only one of the devices attached to the RS-485 network.

CAN Termination

Proper CAN bus termination minimizes reflections and improves reliability. The CAN port allows an internal ter-
mination resistor to be placed across the CAN_H and CAN_L connections by DIP Switch Setting.

Only the two devices physically located at the endpoints of the CAN bus should be terminated.

Cscape Programming via Serial Port

The X5/X5 Prime OCS MJ1 serial port supports CsCAN Programming Protocol. If a PC COM port is connected to

the X5/X5 Prime OCS MJ1 serial port, Cscape can access the X5/X5 Prime OCS for programming and monitoring.
Programming can also be done via the CAN port, USB port or Ethernet. Successful communications with USB-to-
serial adapters vary. If in doubt, Horner APG offers a USB to serial adapter: part number HE-CPK.

Ladder-Controlled Serial Communication

Using Serial Communication function blocks, both MJ1 and MJ2 support Generic, Modbus Master, and Modbus
Slave Protocols. In addition, external modems can be connected and accessed using Init and Dial and Answer
Modem function blocks.

Downloadable Serial Communication Protocols

Both MJ1 and MJ2 also support downloadable protocols, such as Allen Bradley DF1, CsCAN Master, GE Fanuc
SNP and Modbus Master.

NOTE: Refer to the download section of our website for the list of latest supported protocols.
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Configuration via Mini-B USB
NOTE: The unit must be connected via the mini-USB port to the PC or laptop.

Itis possible to load the program and monitor data via the Mini-B USB. To load via Mini-B USB, configure the com-
munications port in Cscape as follows:

Select Tools from the toolbar > Application Settings > Communications > USB button
Itis possible to download or upload and use the data monitoring functions once connected.

NOTE: It is advisable to use an isolated USB cable between the PC or laptop and the X5/X5 Prime when third party
devices are connected to the X5/X5 Prime to avoid damage to the PC or laptop and/or the X5/X5 Prime.
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POt DS P i ON 108
CANT Port Wiring 108
Cscape Programming via CAN . . 109
Ladder-Controlled CAN Communication ... ... .. . .. 109
Using CAN for I/0 Expansion (Network /O) ... ... .. . . 109

NOTE: For additional CAN information, refer to the CAN Networks manual, MAN0799 (MANO799) using Horner's
Documentation Search page.

OCS models provide A CAN network port, which is implemented with 5-pin connectors. The CAN port allows the
OCS to exchange global data with other OCS controllers and to access remote Network I/O devices (SmartStix,
Smart Blocks and Smart Rail Modules). The port also supports pass-through communications for programming mul-
tiple OCS controllers over the CsCAN network. Also, the CAN port supports CsCAN, CANopen, J1939, and
DeviceNet Master (layer 3 as a selectable option).

Port Description

The OCS CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link layer standards. Also,
since the CAN ports are powered by an internal isolated power supply, external CAN power is not required.

NOTE: The CAN port does not supply power to the network.

CAN1 Port Wiring

CAN Connector
CAN Network & Power Port Pin Assignments
Use the CAN Connector - = =
when using CsCAN or m iyl | Pescnptmn
other CAN network. V- CAN and Device Ground - Black
. CN_L CAN Data Low - Blue
T Rating: N
zrgtje? ir?—llgsg SHLD Shield Ground - None
(0.50 - 0.78 N-m) 4 CN_H CAN Data High - White
Vi Positive DC Voltage Input
(10-30VDC) - Red
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Cscape Programming via CAN

The CAN port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via PCI card or USB),
and the PC CAN port is connected to the OCS CAN port, Cscape can access the OCS for programming and mon-
itoring.

In addition, the OCS supports single-point-programming of all OCS devices that are connected to the CAN port net-
work. If the PC COM port is connected to the OCS MJ1 serial port, the OCS can act as a pass-through gateway
allowing Cscape to access all OCS devices that are attached to the CAN port network.

Ladder-Controlled CAN Communication

Using Put and Get Network Words function blocks, the CAN1 port can exchange digital and analog global data with
other devices (nodes) attached to the CAN network.

In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to regularly announce
their presence and to detect the presence (or absence) of other nodes on the network.

Using CAN for I/O Expansion (Network 1/0O)

Connecting network 1/O devices (SmartStix, SmartBlock, SmartMod, or SmartRail) to the OCS CAN1 port, allows
the OCS 1/O to be economically expanded and distributed. A variety of modules are available for this purpose.
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Ethernet Communications

Ethernet Module Protocols and Features ... ... ... .. . 111
Ethernet Systems Requirements .. ... .. . . 111
Ethernet Module Specifications ... .. ... ... 112
Ethernet Module Configuration ... ... .. 112
Ethernet Module Protocol Configuration ... ... .. . . 114

NOTE: Refer to the Ethernet Supplement on the Document Search page for more details.

Ethernet Module Protocols and Features

The X5/X5 Prime controller supports the following:
1. Downloadable Protocols: Modbus Client
2. ETN300 Protocols: ICMP (Ping), EGD, Modbus Slave, Ethernet I/P, FTP, ASCIl over TCP/IP
3. Supports a maximum of 4 WebMI simultaneous connections
4. Ethernet SmartRail

The following table describes the Ethernet Module Protocols and features supported by the Ethernet port on the
X5/X5 Prime.

Protocol / Feature Protocol / Feature Description
ICMP (Ping) Internet Control Message Protocol
EGD Ethernet Global Data
SRTP Slave (90-30 Service Request) | Service Request Transfer Protocol
CsCAN TCP Server Horner APG CsCAN over Ethernet (for Cscape to OCS programming)
Modbus Slave Modbus over Ethernet
Ethernet / IP ODVA CIP over Ethernet
FTP (File Server) File Transfer Protocol
HTTP (Web Server) HyperText Transfer Protocol (Web Server)
ASCIl over TCP/IP ASCII Data over Ethernet
NTP Protocol Network Time Protocol (Obtain clock from web-based server)

Ethernet Systems Requirements

Full Ethernet functionality requires PC running Cscape Programming Software Version 9.8 or later (for con-
figuration).
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Ethernet Module Specifications

Speeds 10 BaseT Ethernet (10Mbps) 100 BaseTx Fast Ethernet (100Mbps)
Modes Half or Full Duplex

Auto-Negotiation Both 10/100Mbps and Half/Full Duplex

Connector Type Shielded RJ-45

Cable Type

(Recom‘r’:en ded) CATS5 (or better) UTP

Port Auto MDI/MDI-X (Auto Crossover)

Ethernet Module Configuration

NOTE: The following configuration is required for all applications regardless of the protocols used. Additional con-
figuration procedures must be performed for each protocol used.

To configure the Ethernet Module, use Cscape Programming Software to perform the following steps:
1. Onthe main Cscape screen, select the Controller menu and its Hardware Configuration sub-menu to
open the Hardware Configuration dialog.
2. If configuring a different OCS Model than the one shown in the Hardware Configuration dialog, click on the
topmost Config button, select the desired O‘CSngdefl, and then click Cﬂ)K.p

7 Hardware Configuration X

w

1 Controller | Local /0| CANT (CsCAN) 10| LANT 10|

Series XL OCS Series v Description:

'Touch screen Operator Control Station with
Device Type [X5 ~| fixed 110
Model #: [HE-X5 =] Properties

Display Type: 272 by 480 LCD
Network Ports pay Ty |

CANT [CSCAN - Config Keypad Type: |Touch +4F keys
Program Memory: |2048 K Bytes

CAN2
Network Type: |CSCAN

LANT |ETN300 Config
‘Advanced Ladder Functions

N2 Supports Analog Data

Real Time Clock Support
Supports Retentive Data

Serial Ports Config

OCS Wi-Fi Module Config

Auto Config
OK Cancel ‘ ‘ Help ‘

3. Click the Config button to the right of the LAN1 for LAN 1 or LAN2 for LAN 2, revealing the Ethernet Module
Configuration dialog.
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LANT Configuration X ‘
Register Usage
[ Use DHCP

Default Settings Register

IP Address: | 192 . 168 . 254 . 128 on ~| [ Use CANID for last Octet

NetMask: | 255 . 255 . 255 . 0 Name:

Gateway.: [ 0 . 0 .0 .0

DNS Server. [ 0 o .0
Status:

Version:

Protocol Support

Resident Protocols
[]ICMP (Ping)
[]EGD (Ethemet Global Data)
[C]SRTP Slave (30-30 Service Request)
[[]Modbus Slave
[ Ethernet/IP
[JFTP (File Server)
[CJHTTP (Web Server)
[C]ASCII Over TEPAP
[JNTP Protocol(Obtain clock from web based server)

Configure Selected Protocol

Downloadable Protocols
ETN1IT [~ None — - | ‘

None | ‘
oK

cancel

4. Configure the Ethernet Module parameters as follows:

IP Address: Enter the static IP Address for the Ethernet Module being configured. NOTE: IP
Addresses are entered as four numbers, each ranging from 0 to 255. These four numbers are called
octets, and they are always separated by decimal points.

¢ Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local net-
work. Typical local networks use Class C IP Addresses, in which case the low octet (rightmost number) is
used to uniquely identify each node on the local network. In this case, the default Net Mask value of
255.255.255.0 should be used.

¢ Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication out-
side of the local network. To prevent the Ethernet Module from communicating outside the local network, set
the Default Gateway IP Address to 0.0.0.0 (the default setting).

« Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS register
will have the Ethernet Status word written to it. The table shows how this register value is formatted and
explains the meaning of each bit in the Status Word.

Ethernet Status Word Register Format
High Byte Low Byte
Bit 16| Bit 15| Bit 14| Bit 13| Bit 12| Bit 11| Bit 10| Bit9| Bit 8| Bit 7| Bit 6] Bit5| Bit4 | Bit3 | Bit2 | Bit1
0 0 Dup | Spd 0 Rx Tx | Link TCP Connections
Status Bit Status Indication — Status Values.
Minimum | Maximum
0 Reserved Always 0
Dup Link Duplex (Auto-Negotiated) 0 = Half Duplex| 1 = Full Duplex
Spd Link Speed (Auto-Negotiated) 0=10Mbps | 1=100 Mbps
Rx Receive State 0 = Inactive 1 =Active
Tx Transmit State 0 = Inactive 1= Active
Link Link State 0 =Down 1=Up
TCP Connections Total Number of Active TCP Connections 0 40
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Version Register: Optionally enter an OCS Register reference (such as %R101) to indicate which 16-bit OCS
register will have the Ethernet Firmware Version written to it. For example, for Ethernet Firmware Version 4.30, the
Version register will contain 430. This version will only change with a complete controller Firmware Update.

Optionally, check the Use CAN ID for last Octet box in order to leave the last octet of the IP Address editable by way
of changing the controllers CAN ID. This does not affect the Net Mask or Gateway settings.

NOTE: Get settings from may be specified for Configuration or Register.

If set to Configuration, addresses will be obtained from the Default Settings column. They may temporarily be
changed via the X5/ X5 PRIME System Menu which is useful to obtain an Ethernet connection initially. These tem-
porary settings will revert to those configured in Cscape each time the controller is placed in RUN mode, i.e. after a
program download or upon power-up. Refer to the System Settings and Adjustments chapter for more details.

If set to Register, addresses will be obtained from the configured register only, whether via the application code or
a data field on the touchscreen or any combination thereof. The Default Settings column is ignored in this case. The
X5/ X5 PRIME System Menu will reflect the current addresses, but the addresses may not be edited from the Sys-
tem Menu.

NOTE: While assigning registers to IP address, Net Mask, Gateway, Status, and Version are optional, it is highly

recommended to assign registers to these fields for the purpose of troubleshooting.

Ethernet Module Protocol Configuration

The Protocol Support area contains a list of the resident protocols supported by the platform being configured. To
activate a protocol, check its checkbox.

For protocols that require additional configuration, click on a listed protocol to select it and then click the Configure
Selected Protocol button. This will open a new dialog with configuration options for the selected protocol.

For detailed information on individual protocol configuration, refer to latest version of the Ethernet Manual,
SUP0740.
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OV IV W 116

Protocol Device Driver Selection ... ... 117

Network Configuration ... .. . . 118

Device List and Device Configuration ... ... . . 120

S AN LSt 122
Overview

Through loadable protocol device drivers, certain models of the OCS family can provide the ability to exchange data
with remote devices such as variable-frequency drives, PLCs and remote I/O devices. This feature greatly expands
the OCS’s control capability with negligible effect on the OCS ’s ladder scan time.

Remote devices that communicate serially must do so under certain rules of data transfer known as a protocol.

Many device manufactures have created their own protocol for communications with their device. For a OCS to com-
municate with a specific device, it must be loaded with the corresponding serial communications protocol device
driver that supports that protocol.

A limited number of protocol device drivers are packaged with the Cscape distribution; however, as more are
developed, they will be made available as add-on packages. A device driver is typically distributed as a Windows
module, which contains the configuration menus, help files and the target executable driver code. When updating
device drivers, an install routine loads the device driver to the Cscape directory structure and makes that driver avail-
able to Cscape applications.

Once installed, the protocol device driver can be included as part of a Cscape application by selecting it from a list of
installed protocol device drivers and attaching it to the desired serial port (Home > Protocols). Only one protocol
device driver can be associated with a serial port, though some OCS models support multiple protocols on a single
Ethernet port.

Once the protocol is selected for a specific port, that port must be configured to match the bit transfer size and rate
of the target device(s). This is configured under the Network Config menu, which contains port specific information
such as the basic serial port parameters (i.e. baud rate, stop bits parity, retries, etc.). In addition to the serial port
parameters, this menu also contains the transaction scan update control configuration and any network level pro-
tocol specific configuration.

Once the network is configured, each device on the serial communications network must be configured. For some
communications (i.e. RS232), the network can be limited to one device. The devices are configured under the
Device Config menu, which contains an arbitrary device name, the device ID and optionally a OCS status register
that contains any device fault information.

Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of data
between alocal (OCS ) register(s) and a remote device register(s). These entries are created under the Data Map-
ping menu, which contains a OCS register, a target device ID, a target device register address, the number of
registers to transfer, and update type.

Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. Polled type
entries initiate a transaction with the remote device on every transaction scan. Triggered type entries only initiate a
transaction when a corresponding local (OCS ) binary trigger register is set. Once a triggered type transaction com-
pletes, the protocol device driver resets the local (OCS ) binary register to indicate completion.
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These basic types are also subdivided into read or write operations. For polled operations, a Read operation only
reads from a remote device. Likewise a Read/Write operation continuously reads from the remote device unless the
target OCS register value changes from one ladder scan to another. In this case, the new OCS value is written to
the target device. For triggered operations, only a read or write action is available.

When downloaded to the OCS , the Scan List is scanned sequentially to generate data transactions with the remote
device. This transaction scanning can be on a continual basis (automatic) or controlled from ladder logic (manual)
once a complex connection is created via a program. The specific transaction-scanning mode is selected from the
Network Config menu.

Protocol Device Driver Selection

Protocol Config *

Serial Protocols

MJ1 |

-- Mone -

(VIPR CT R Modbus CMP v 4,02 |
GE 5MP [Series 30 Protocol] « 3.07

Ciw |GPS Protocol v 317 ‘

Mitzubishi Fx Seres PLC « 3.07
Modbus Master w 4.05

MJ3 [~Tione - A |
|

Ethemet
ETN1/1 |- None - | | | |
ETN1/2 [~ None - =l | | |
ETN2/1 [~ None - =l | | |
ETN2/2 |- None - =l | | |

From the Cscape Home > Protocols menu, select the port drop-down box to select a protocol device driver. All pro-
tocol device drivers currently loaded in Cscape are displayed in the drop down selection along with their version
numbers. A selected protocol can be removed by selecting None from the drop-down selection. Some OCS models
can be limited in the number of ports or number of protocol device drivers that can be selected. Once a protocol is
selected, the Network, Devices and Data (Scan List) must be configured through corresponding dialogues access-
ible through the respective buttons (Network, Devices and Scan List).
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Network Configuration

Metwork Config (Modbus Master) >

— Port Configuration

Baud Rate: |EEAL Pratocol |Modbus ATU = |

Parity: | None v Mode: fRc.o32 |
Data Bits: |8 | Reties: [~ (0-255]
Stop Bits: [ E Timeout [Toppn  mSec

Handshake:  [None ~]  SlaveSpeed [Faq E

—pdate Scan
= Automatic

Update Interval: ||:| mSec ReacquireTime: |-||:||:||:||:||:| mSec

i Manual
Trigger: I M arne: I ;I o>
D Select: I M arme; I LI 16-EIT

—kaster 1D # Address

Address: IEI

— Dizable Metwaork

Register: I M arne: I LI BT
— Status

Reqister: I Name:l ;I 4 » [zz-EIT

Frotocaol Help | (] I Cancel

Network Configuration provides the required parameters to configure the network. Each protocol is different and
may not require the entire Network Config field. Please refer to the table below for the options in the Network Config
field.
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Network Protocols

Baud Rate,
Data Bl.ts’ These field define the bit level transfer over the serial port.
Stop Bits,
Parity
None — No handshake lines are used
Multidrop Full - Rx remains active while Tx is occurring.
Handshake | Multidrop Half — Rx is shut off while Tx is occurring.
Radio Modem — Wait for CTS acknowledgment before transmitting (legacy radio modem support).
Protocol If a driver supports multiple protocols, it is selected here, (i.e. Modbus supports RTU or ANSI).
Mode Specifies if port operates in RS232 or RS485 mode.
Retries Specifies number of times a transaction is retried on a failed response.
Timeout Specifies the amount of time for a device to wait for a valid response.
Update Interval — Specifies the update interval at which all
the mapped entries are executed.
Automatic Reacquire Time — Specifies the amount of time to wait
before attempting communications with an offline device.
Trigger — Specifies the binary register that a single trans-
Update action scan of the Scan List.
Scan
Manual ID Select — If an analog is specified in the field, the ID
Select filter is enabled.
Status Specifies the starting OCS register of eight (8) consecutive registers (4-32bit counters), which
Register provide an indication of the network health.
izz:::; Specifies the OCS’s device (network) ID if a master ID is required by the protocol.
::I):)OCOI Provides protocol specific help.
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Device List and Device Configuration

Device List

B | Device List (Modbus Master) x

Name | D I Status I On Error

Add

Delete

Config

i

Cancel

This configuration list is reached from the Device button on the Protocol Config screen and provides a list of the con-
figured devices on the Network. Devices must be created and exist in this list before corresponding Scan List
entries can be created for this device. Typically, the number of entries is limited to 128 devices.

¢ Add - Opens the Device Config dialog to add a new device to the list.

¢ Delete - Remove selected device from list (all corresponding Scan List entries are also removed).

¢ Config - Invoke the Device Config dialog for the currently selected device. This can also be accomplished by
double-clicking a device entry.

¢ Mapping - Invoke the Scan List limiting the entries displayed for the selected device.
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Device Configuration

Dialog X

Device

M ame: |

ID: 1 [Slave Address)

Device Options

™ Swap words on 32-bit data

™ Target returns 32-bit on single register request

Device Type: |M0dicon PLC 5-Digit Addressing j
Mode: |Device Supportz all modbus write function codes j
Dizable Device
Fegister: | Mame: j BT
Status
[” Enable
Address: |0 J 16-BIT
i i+
Ok | Cancel |

This configuration is reached from the device list when adding or modifying an existing device. While each protocol
is somewhat different and can contain protocol specific field, all protocols typically support at least:

L]

Device Name - Specifies a tag name for this device. This tag name is used in the Data Mapping con-
figuration to identify this device. This allows device addresses to be modified without the need to update all
associated Data Mapping entries.
Device ID - Specifies the target device communications ID or station address.
Swap Words on 32-bit Data - If a Scan List entry is configured to transfer 32-bits and this option is checked,
the high and low 16-bit values are swapped when transferred between the target and OCS.
Disable Device - From Cscape 9.90 SP3 and firmware 15.40 onwards, disable device feature has been
added in protocol device configuration. This option is used to disable a particular slave configured in the net-
work. Single bit register has to be configured to use this function. Setting the bit high disables the slave and
OCS will not send any serial (TCP for ethernet protocols) packets only to this slave until the bit is high. Set-
ting the bit low enables the communication with the slave again.
Status Enable - This checkbox enables device status to be displayed and controlled from two consecutive
16-bit registers.
Status Address - Enter the starting 16-bit OCS register of two consecutive registers used for device status.
The first register contains the protocol device driver specific error code while the second register contains the
index of the offending Scan List entry.
Status Modes:

a. Stop on Error - Specifies that communications be only reattempted after offline status when the cor-

responding device status register is cleared.
b. Retry on Error - Specifies that communications be reattempted either during the reacquire interval or
when the corresponding device status register is cleared.
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Scan List

B ' Scan List (Modbus Master)

Edit View Sort

Index | Local Name | Register | Type | Dev Name | ID | Target ‘ Length |

Delete

Config

i Jd

Edit Names

Cancel
Fiker By Device: [.._ oy ... | oK

it

This configuration list is reached from the Scan List button on the Protocol Config screen or the Mapping button on
the Device List screen and provides a Scan List of the Data Mapping entries. To transfer data between the OCS and
remote target, a Scan List must be created that defines each transaction. Each mapping entry (transaction) con-
tains the source and destination registers, the number of consecutive registers transferred, the direction of the trans-
fer and what triggers the transfer. Typically, the number of entries is limited to 512.

NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided to

change the order of the list. Each entry also has an identifying index. If the device status register is enabled and a
transaction failure occurs, the status register indicates the index number of the transaction that failed.
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Menu

« Edit > Copy All - Copies Scan List to clipboard in a tab delimited format suitable for pasting into an applic-
ation like Microsoft Excel.

¢ Edit > Paste - Loads Scan List from clipboard. Pasted items are added to the scan list even if they are duplic-
ates.

¢ View > Toggle All Name View - Expands Scan List such that each point and corresponding local name is
displayed.

¢ Sort Scan List by different criteria. The firmware will scan the devices based on the order they are displayed
or sorted. There are four ways to sort the scan list:

a. By Local Address — Sorts the list by local register address in increasing order.

b. By Target Address — Sorts the list by target register address in increasing order.

c. By Device Name — Sorts by device name, then target address.

d. Interleave Devices — This sort evenly distributes request among the different devices. Instead of
requesting 100 blocks from device A, then 100 blocks from device B, one requests is sent to device A,
then one request is sent to device B until all the data has been requested. This is useful for devices
that may have a timeout timer because the time between each scan for a particular device is min-
imized. This sorting options usually doesn’t affect performance.

Buttons

¢ Add - Opens the Data Mapping dialog to add a new entry to the Scan List.

¢ Delete - Removes selected entry from Scan List

¢ Config - Opens the Data Mapping dialog for the currently selected entry. This can also be accomplished by
double-clicking an entry.

« Edit Names - Invokes the Edit Names dialog for the currently selected entry. The Edit Names dialog
provides the ability to create OCS program names for each point in the transaction.

Display Control

Filter by Device - Limits displayed entries to only those assigned to the indicated device. To show all entries select
—All--.
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Data Mapping Configuration (Scan List Entry)

Dialeg >

Target

Device Mane |test 1] ﬂ

Diewice Register | j [ 32 bit access

Length 1

Local

Register | Marie: | j

UpdateType

{* Palled Fead " Triggered Fead
™ Polled Read/white (" Triggered \rite

" Polled Read/write Init

Trigger Regizter J

Cancel |

Target

* Device Name - Selects the target device (by tag name) to use for this transaction. Only those device entries
previously created from the Device Config menu are available.

« Device Register - Specifies the target device’s register to use for this transaction. This designation is target-
specific. The configuration menu displays an error if a specified address is unacceptable. Generally, the
data type of the local (OCS ) register must match the data type of the device register.

¢ The Right Arrow button - Displays protocol device driver specific help for the target addressing. Note that
some devices can require register addresses that exist on 8-bit, 16-bit or 32-bit boundaries.

¢ Local Register - Specifies the local (OCS ) register that is the source or destination for the transaction.

¢ Local Name [Optional] - Optionally allows selection of a OCS register by name <or> creation of a name for
aregister already selected by direct reference. Created names can be used thereafter to specify the local
(OCS ) register in ladder or graphics address fields.

¢ 32-Bit Access - Allows two local (OCS ) 16-bit registers to be treated as a single 32-bit value. For example,
if the value in either 16-bit register is modified, both registers are written to the device. Device-specific, 32-bit
word swapping options also apply to this designation. Since the transaction is treated as a 32-bit access, the
length is generally limited to 16. Note that some protocols can disable this feature.

¢ Length

a. Specifies the number of consecutive device registers that are transferred in this transaction. Note that
some protocols can limit the length that can be transferred. However, typically the length is limited
to 32. The configuration menu displays an error if a specified length is unacceptable.

b. If allowed, specifying a length greater than one (multiple consecutive register transfers per
transaction) is more efficient than creating a single transaction for each register. This group-
ing of registers per transaction can significantly reduce the transaction scan time; however, update
types that include writing on a polled basis require additional consideration.

c. On Read/Write and Read/Write/lnit update types, the write transaction only occurs when the local
(OCS ) register value changes. If the length is greater than 1 for Read/Write and Read/Write/Init
types, only the local register(s) that change in value are written. More specifically, only one write
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transaction occurs per scan per mapping entry for the register or consecutive sub-group of local
registers that changed in value. Depending on the protocol, the number of points written with that
write transaction are limited either to one or the number of consecutive points that changed value.

d. Therefore, if several local registers (specified in a single mapping entry) change in value
prior to a transaction scan, it takes SEVERAL transaction scans to complete all the write
operations. Furthermore, all write operations are completed before a read operation is sched-
uled.

e. For Manual Update (transaction) scans (i.e. dialup modem), it is recommended that all
Read/Write Scan List entry lengths be limited to 1.

Update Type

This field specifies the direction and what triggers the transfer of data between the OCS and target device for a map-

ping entry.

¢ Polled Read - On every transaction scan, a read-only target device register(s) transaction occurs.
¢ Polled Read/Write

a. Onevery transaction scan, a read target device register transaction occurs unless a local register

value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change value
between transaction scans, it takes several consecutive transaction scans to write each changed
register.

When the OCS is placed in RUN mode, the initial action for this mapping type is a read target
register transaction. This transaction initializes the local (OCS ) register(s) to match that of the
remote device register(s). Thereafter, any change to the corresponding OCS register(s) triggers a
write operation to the remote device.

* Polled Read/Write/Init

a.

C.

On every transaction scan, a read target device register transaction occurs unless a local register
value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change value
between transaction scans, it takes several consecutive scans to write each changed register.

When the OCS is placed in RUN mode, the initial action for this mapping type is a write target
register transaction. This transaction initializes the target device register(s) to match that of the local
(OCS) register(s). Thereafter, any change to the corresponding OCS register(s) triggers a write oper-
ation to the remote device.

The initial write transaction does not occur until after the first logic scan of the OCS . This allows
registers to be initialized locally before Writing to the target device register(s).

¢ Triggered Read - A read transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the read transaction is complete (or the device is offline), the OCS trigger register is
cleared by the OCS . This update type can be used for occasion data accesses such as retrieving trend data.
Note that this operation increases the associated transaction scan time and can cause the Update Interval
Exceeded Counter to increment on a tightly adjusted update interval.

¢ Triggered Write - A write transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the write transaction is complete (or the device is offline) the OCS trigger register is
cleared by OCS . This function can be used for occasion data accesses such as sending recipe data. Note
that this operation increases the associated transaction scan time and can cause the Update Interval Time
Exceeded Counter to increment on a tightly adjusted update interval.
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User Interface

Screen Specifications

Displaying and Entering Data ... ... . 128

Screen Navigation
Ladder-Based Screen Navigation

Beeper Acknowledgment .. . . 131

Touch (Slip) Sensitivity
Alarms
Removable Media
Screen Saver
Screen Brightness
Touch Screen Pressure

This chapter presents the user interface (or operator view) of the X5/X5 Prime and some of the model specific char-

acteristics of the X5/X5 Prime as compared to the rest of the OCS line. This chapter does NOT cover building
screens or using the CSCAPE graphics editor. For instructions on creating screens and using the graphics editor,
refer to the Graphics Editor Help File in CSCAPE.

Screen Specifications

Display Type Resistive 4.3” Touchscreen (450 cd/m? (nits)
Resolution WVGA (480x272)

Color 65K Color

Screen Memory 22MB

User-Programmable Screens 1023

Backlight White LED
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Displaying and Entering Data

— Roller 2-A

Start Stop

Manual

Automatic

Clean @Running [Hours 1274 v
OCIeaning IHours 34

Multiple objects are provided for displaying data such as virtual panel lights, push buttons, numeric value displays,
bar graphs, meters, graphs and animated bitmaps. On the X5/X5 Prime, these graphical objects (through ladder
manipulation of attribute bits) can change color, flash, or change visibility to attract operator attention.

On objects that accept user input, the input is provided by touching the object or alternately changing an OCS
register (i.e. function key registers). Objects that allow input generally have a raised 3D appearance. An exception
is the binary type objects, such as buttons, which are shown in a depressed 3D appearance when in the ON state.
Objects that normally accept touch input may be disabled through program control (through ladder manipulation of
an attribute bit). If an object is disabled, the object’s representation changes to a 2D appearance.

On objects that represent non-discrete information, more action may be required beyond that of simply touching the
object. For example, the slider object requires the operator to touch and slide the control in the direction desired.
Alternately, alpha-numeric entry objects invoke a pop-up alpha-numeric keypad for additional user input. The
alpha-numeric keypad is discussed below.

NOTE: If the numeric entry object displays >>>>>>>the value is too big to display in the field or is above the max-
imum for an editable field. Likewise, if the numeric entry object displays <<<<<<<in a numeric field, the value is too
small to display or is below the minimum for an editable field.
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Alpha-Numeric Keypad

To allow entry of a specific number or text, several of the input objects invoke a pop-up alpha-numeric keypad when
the object is touched. An example of the alpha-numeric keypad invoked from a numeric input object is shown
below. Once invoked, the operator may touch the appropriate keys to enter a specific value. When entering a value,
the alpha-numeric keypad is in one of two modes [new-value or edit-value].

New-Value Mode - Generally, when the alpha-numeric keypad is first invoked, it is placed in new-value mode. Ini-
tially, the alpha-numeric keypad displays the current value with all the digits being highlighted. Once the first digit is
entered, the current value is erased from the display and the new digit is placed in the first location. Thereafter, no
digits are highlighted, and new digits are added to the rightmost position while the other digits are shifted left.

Edit-Value Mode - Edit-value mode may be entered from the initial new-value mode by pressing either the left or
right arrow key before any digit key is pressed. The result will be a single character highlighted. The user may then
either touch a key to change the digit at the selected position or the up and down arrows may be used to add or sub-
tract (respectively) from the selected digit. The user may then use the left or right arrow keys to select a new pos-
ition.

Once the desired value is entered, pressing the Enter key moves that value into the object (and the corresponding
OCS register) and the alpha-numeric keypad disappears. Alternately, pressing the ESC key any time before the
Enter key cancels the operation, leaves the objects current value unchanged, and the alpha-numeric keypad dis-
appears.

NOTE: Each numeric entry object has a configured minimum and maximum value. If the operator enters a value out-
side of the configured range, the new value is ignored when Enter is pressed and the current object value is NOT
changed.

Since the alpha-numeric keypad services several different graphical objects, certain keys on the alpha-numeric
keypad may be disabled (grayed) when the keypad is invoked for certain objects. The following describes the
alpha-numeric keypad variation based on object.

Numeric Object - When editing a numeric value, the [+/-] or the [.] key are disabled (grayed) if the object is NOT
configured for floating-point value or a signed value.

Password Object - When editing a password value, the arrow keys, [+/-], and the [.] keys are disabled. Addi-

tionally, overwrite mode is disabled. When entering digits, the pop-up keypad hides the value by displaying *’ altern-
ately for each digit.
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ASCII Object - When editing an ASCII value, an ASCII keypad is displayed as shown Figure 14.2. The ASCII
keypad has three (3) modes: numeric, symbols, and alpha. In Alpha mode, the Caps Lock button may be pressed to
access capital letters. When you first enter this editor typing, a character will overwrite the entire old string and start
a new entry. You may press the back space arrow to delete the previous character. Pressing Enter will save the
entry; pressing ESC will cancel the edit and return the string to the previous value.

Text Table Object - When editing a Text Table Object, all the keys except the Up and Down arrow keys are grayed
and disabled. The next text selection is made by pressing either the Up or Down arrow.

Time/Date Object - When editing a Time/Date Table Object, all the keys except the Up, Down, Left and Right arrow
keys are grayed and disabled. The specific field (i.e. hour or minutes) is selected using the Left and Right arrows.
The value in the selected field is changed by pressing either the Up or Down arrow.

Screen Navigation

To allow the operator to change screens, a Screen Jump Object is generally used. This object may be visually rep-
resented as a 3-D button (responding to touch) or remain invisible and logically tied to an OCS register. An optional
system ICON may be configured for display along with the legend, which aids in identifying the object as one that
causes a screen change.

\ Ol
' SETTINGS ‘W

Screen jumps can also be triggered on other keys or based on control logic for more advanced applications. To
allow the operator to change screens, a screen jump object is generally used. This object may be visually rep-
resented as a button (responding to touch) or remain invisible and logically tied to an OCS register. An optional sys-
tem ICON may be configured for display along with the legend, which aids in identifying the object as one that
causes a screen change.
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Ladder-Based Screen Navigation

Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D registers to make
them screen coils. These coils have two modes: switch and alarm. If the ladder program energizes an alarm display
coil, the screen associated with this coil is displayed and overrides the normal user screens. This is designed to
show alarm conditions or to display other ladder-detected events. When the text coil is de-energized, the previous
screen that was being viewed before the alarm is returned.

The switch display coil switches to the associated screen when it is energized. Once it is de-energized, the screen
remains until it is switched by the user or ladder.

Input_1 [ ) Force Screen: 1
— I ——
oot Screen 1
Input_2 [ ) Switch Screen: 2
— I ——
%0002
Screen 2

There is also a system register that can be used to for control-based screen navigation. %SR1 can be read to
determine the current screen or written to change the current screen. Refer to the On-Line help in Cscape for more
information on control-based screen navigation.

Beeper Acknowledgment

The X5/X5 Prime contains an internal beeper that provides an audible acknowledgment when an operator touches
a graphic object that accepts touch input. When the graphic object is enabled, a short 5ms tone is emitted. When
the graphic object is disabled, a longer 100ms tone is emitted to announce that the graphical object is not currently
accepting the touch input.

If beep acknowledgment is not desired, the beeper function can be disabled from the System Menu.

Touch (Slip) Sensitivity

Touch slip sensitivity is preset to meet most applications; however, adjustment is available to reduce the sensitivity
for touch release. That is, once a graphical object (button) is touched and held by a finger, the default touch slip
sensitivity allows for a slight slip of the finger on the graphical object before the X5/X5 Prime assumes touch been
released (equates to approximately a quarter inch of movement with a stylus).

In some applications (such as jog buttons) where the operator is pushing a button for a period of time, the amount of
slip while holding a button pressed may exceed the default sensitivity. To increase the amount of tolerable slip and
prevent false releases of the button, the X5/X5 Prime allows adjustment of the allowable slide up to 5x the default
value.

To enable the touch (slip) sensitivity, first an OCS data register must be allocated through the Graphics Editor Con-
figuration menu for Display Settings. Once a Touch Sensitivity register is assigned, that register may be modified
[range = 1 (Low) to 5 (High)] to the desired slide amount. If a value outside the valid range is entered in the touch
sensitivity register, it is ignored, and the last valid value is used.
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Alarms

Alarm presentation to the operator is highly configurable and beyond the scope of this document to describe fully.
For more information, refer to the graphics editor help file in CSCAPE. This section presents a typical configuration
thereby providing an introductory description on what the operator should expect.

The alarm object is generally used to enunciate alarms to the operator. While the display characteristics of this
object is configurable, it is generally displayed as a button that changes colors to indicate the highest state of the
alarm(s) in the alarm group it is monitoring. The following indicates the priority of the alarm states and the default col-
ors associated with these states.

_ (Yellow) Acknowledged Alarms Exist

To view, acknowledge and/or clear alarms, the operator must access the alarm viewer. This is accomplished by
touching an (enabled) alarm object. When accessed, the alarm viewer is displayed as pop-up alarm viewer dialog.

Alarm Viewer

01713 13:13 RTH
*% Undefined Alarml *%

Ack
RME

The currently selected entry is indicated by a yellow highlight which can be moved up or down by touching the arrow
buttons or by directly touching an entry. If more entries exist than can fit on the page, a scroll bar is displayed on the
right side that also indicates the current relative position.

The current state of the displayed alarm is indicated by its color and optionally by an abbreviated indicator after the
date/time stamp (ALM, ACK, RTN). The operator can acknowledge an alarm by selecting it from the list and touch-
ing the ACK button. The operator can also clear an alarm if that function is enabled in the alarm object. If not
enabled, the Clear buttons are grayed and do not respond to touch. Once view operations are complete, simply
touch the Esc button to remove the pop-up alarm viewer.

NOTE: OCS registers %SR181 and %SR182 are available for ladder use, which indicate presence of unac-

knowledged or acknowledged alarm (respectively). The screen designer may implement these registers to switch
screens or activate the beeper to attract the operator’s attention.
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Removable Media

The Removable Media Object is generally used to inform the operator on the current state of the removable media
device and allow access to its file structure. The Removable Media Object is displayed as a button that changes col-
ors to indicate the current state of the removable media device. The following indicates the device states and the
default colors associated with these states.

_ (Yellow) Device Full (threshold
adjustable)

To view and perform file operations, the operator must access the removable viewer. This is accomplished by either
touching an (enabled) removable media object or through the System Menu. When accessed, the removable media
viewer is displayed as pop-up removable media dialog.

NOTE: The Removable Media Object can be configured to open the removable media viewer at a certain directory
complete with restrictions on transversing back up the file path. This may be used to restrict operator access to non-

critical files.
Media Directory

SCREENOO . BHMP 153654 01-13-96 1:10p
SCREENO1.BHP 153654 01-13-96 1:13p
SCREEN26 . BHP 153654 01-13-96 1:08p

Free: | 992247808 Total: 992739328
| ’ | Del| F |s I |

4] A V Del Hil ng Pagulrf Esc
The currently selected entry is indicated by a yellow highlight which can be moved up or down by touching the arrow

buttons or by directly touching an entry. If more entries exist than can fit on the page, a scroll bar is displayed on the
right side that also indicates the current relative position.

File operations are accomplished by pressing the appropriate button at the bottom of the Removable Media Viewer.
The configuration of the removable media object that invokes the Removable Media Viewer defines what buttons
are enabled and available to the user. A button is grayed and does not respond to touch if configured as disabled.

The# (Enter) button (if enabled) performs certain operations based on the selected file’s type:
. Change display to parent directory

<DIR> Change display to child directory

bmp, jpeg Display bitmap (if compatible format)

pgm Load application (if compatible model and version)
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Alternately, the (enter) button can be configured to simply load the ASCII representation of the file path (including
the file name) to a group of OCS registers. That pathname can then be used by ladder for opening and manipulating
that file.

Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer.

If the removable media is used in an application, the Removable Media Device requires changing by the operator,
and the application is attempting to write to the removable media when it is removed, the screen designer should
create objects that allow the operator to temporarily halt access to the removable media. This prevents corruption to
the file system if the removable media is removed during a file-write sequence. The graphic objects should set OCS
register %SR174.1 (when requesting the card be removed) and provide an indicator based on OCS register
%SR174.2 (which indicates that it is safe to remove the removable media).

Halt RM Activity

Safe for Removal |z|

Screen Saver

The X5/X5 Prime screen backlight life is typically five (5) years when in continuous use. If the application does not
require interaction with the X5/X5 Prime for long periods of time, the backlight life can be extended by using the
screen saver function. When enabled through the System Menu, the backlight is shut off (screen goes black) after a
specified time of no touch activity on the screen. When the screen saver shuts off the backlight, any operator touch
on the screen or function keys reactivates the backlight.

NOTE: When the screen saver is active (backlight shut off), any initial touch activity on the screen (or function key)
to reactivate the backlight is otherwise ignored by the X5/X5 Prime. Any additional touch activity is also ignored by
the X5/X5 Prime for approximately one second thereafter.

Itis possible for the application to temporarily disable the screen saver by generating a positive transition to
%SR57.16 (coil only) at a rate faster than the screen saver timeout value. This may be desired while waiting for
alarm acknowledgement.

Screen Brightness

The X5/X5 Prime provides a feature that allows screen dimming for night operation. To enable this feature, the
application must access and control system register %SR57 (Display Backlight Brightness). Screen brightness is
continuously variable by driving %SR57 through the range of 100 (full bright) to 0 (full off). It is left to the screen
designer on if and how to present a Screen Brightness control to the user.

NOTE: The backlight life can be extended by dimming or powering off the backlight.
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Touch Screen Pressure

The Horner XL series OCS controllers have a resistive touch screen that allows mechanically detecting touch
events. The resistive touch screen works by measuring the resistance between two layers of conductive film.

-
PET FILM ‘ SPACER DOT
TOP CIRCUIT LAYER ITO CONDUCTIVE COATING
ITO CONDUCTIVE COATING BOTOM CIRCUIT LAYER
GLASS OR ACRYLIC BACKING PANEL
.

NOTE: Touch creates contact between resistive circuit layers, closing a switch.

With a unique change to the touch monitoring firmware user can measure the pressure being exerted on the touch
screen. This feature has been added in some Horner XL series controllers. This allows the OCS programmer to be
notified of the touch pressure and it can configure the pressure required to accept a touch event.

There are two system registers that provide this touch feature:
= %SR9 (/0 Name - TCH_PRESSURE) - Records the highest-pressure level of the last touch on the screen
that exceeds the threshold value set in %SR10. This is a range of 0 to 3000. Zero (0) indicates no pressure
and 3000 is the maximum amount of pressure that can be measured.
= %SR10 (I/0 Name - TCH_PRESSURE_TSH) - This register sets the pressure threshold to indicate a touch.
A value of 200 is typically the lightest touch, 600 is moderate and 1000+ is a heavy touch.

These new features allow customizing the feel of the touch screen and can be used to add unique user interface fea-
tures such as having different operations depending on the force of the touch.
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Video Object

Video Object Overview
Opening Video Object in Cscape
Video Properties Configuration
Video Object Performance

Web Cameras

Video Object Overview

The Video Object feature allows two options for video type: Stream and Playback. The Video Object trigger is used
to start, stop, and pause video, and the System Register provides the status of the video object, which supports vari-

ous resolutions and frames per second.

Video Type
(" Stteam  Enter Channel No
| | _J 16-BIT
(% Playback Enter Target Path
l Name I ﬂ 16217
Control
Trigger | Name [ | -
Status Register | Name: | j 1611
Display Properties
Resolution |Valiable size

Frames Per Second IW—FPS

Lef Lo

Attributesy>>

oK | Cancel ‘

Features and Specifications of Video Properties

Streaming Channels

4 channels supported through USB hub

1 channel can be viewed at a time

.mp4
.mov
Playback Formats -MpPg
wmv
Resolution 320x240 (QVGA)

Frames per Seconds

10, 15, 20, 24, 30 & MAX_FPS
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Opening Video Object in Cscape
NOTE: For Cscape 10 please refer to the Help File.

In Cscape, select the OCS and model number by selecting Controller > Hardware Configuration from the tool-
bar.

1. Open the Graphics Editor by selecting the “T” button from the toolbar.

ﬂ
=
2| | pe| B|0|8] @mIR|O| | mifo| wla
Project Toolbox 0 x I main L
2. Inthe Graphics Editor, select the video button from the toolbar.
T
‘E:I‘ Grouping Screens Config Language View Tools Help
v o] |l @)% %] e « 4|=b ]| OB [HiE=
T || |- Al L8] @979): (B oo S o] o | = BT
OO0\
ﬂlUnassigned L”BIank Screen LIJ

)| &[5 ] o B = 20|
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4. Then double click on the icon in the middle to open the Video Properties dialog.
T

s Grouping Screens Config Language View Tools WebMI Help

dit
R )] 8 |j@%% &l « =] Or| [HE

|1 o[ [z (A2 E] @880 B ==o 5] ot of @ = B
‘Olo[ol\]

_#|[Man =|[Screen 11X

Close this dialog to return to ladder editing.

Screen: 1*  [Zoom: 40% 565,87 |96, 06 928x672 1 Objects
Video Type
(" Steam  Enter Channel No
I N I ;I 16-8IT
(¢ Playback Enter Target Path
| MName: | w| Aemn
Control
Trigger [ Name: [ ] -2
Status Register | MName: | j 16-BIT
Display Properties
Resolution [Variable size ~l

Frames Per Second |MA‘-\><_FF"S L] Aftributes>> > |

ok | Cancel |
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Video Properties Configuration
Video Type
Video Properties X
Video Type
¢ Stream [ Enter Channel No
[ I _‘ 14-BIT
+ Playback ]| Enter Target Path
” Narne:[ LI 16-81T
Control
Trigger | Name.| LI @ s
Status Register | Name:| ;I 16811
Display Properties
Resolution |320 % 240 (AVGA)

Led L

Attributes>>>
0K I Cancel I

Frames Per Second | MaxX_FPS

There are two options for video type: Stream and Playback.

Stream — This option can be selected to view live video from a web cam. Four channels are supported through the
USB hub. Only one channel can be viewed at a time. Enter Channel Number directly or through registers in the
Enter Channel No field.

Playback — This option can be selected to view videos that are stored in Removable Media on the controller.
Videos present in both A (microSD) and B (USB) drives are supported and can be viewed. Supported formats includ-
ing .mp4, .mov, .mpg, and .wmyv, can be played.

Select Playback and enter video name in the Enter Target Path field either directly or through registers.

For example: Test1.mp4 (from microSD) or B:\Test2.mp4 (from USB).
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{ Video Pro perties

Video Type
 Steam  Enter Channel No

Video Object

(¢ Playback Enter Target Path

_] 16811

16=BIT

~| @ xo

| Testl.mpd
Control
Trigger Name: |
Status Register Name: |

Display Froperties

Resolution | 320 » 240 (AVGA)

Frames Per Second | Max_FPS

Led Led

- I 14-BIT

Attributes>>> |
DK I Cancel |

Trigger - The video control trigger is used to start, stop and pause video. Video trigger is done by bit level address-
ing. The trigger reserves eight (8) bits and uses the first two (2) bits.

NOTE: The least significant bit is Bit 1.

. High = Start
e Low = Stop

. High = Pause
Bt Low = Play

System Register - The Video Control System Register provides the status of the Video Object. The status word is
16-bits and should be viewed in hexadecimal format.

0x0001 | Videois currently playing

0x0002 | Videois paused

0x00010 | Channel number cannot be greater than 4

0x0020 | File not present or corrupted

0x0040 | Frame per second not supported or not compatible
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Configuring Display Properties
Video Properties X
Video Type
™ Stream  Enter Channel No
[ :I 16-BIT
(¢ Playback Enter Target Path
IT est].mp4 16-BIT
Control
Trigger |%R00001.1  Name: | ~| @ o
Status Register |%R00010  Name: | | seen
Display Properties
Resolution [320 % 240 (QVGA) |
Frames Per Second [MAX_FPS E' Altributes>>> I
20 ~
24
30 oK I Cancel
Max_FPS v |

Resolution Options | 320x240 (QVGA)
Frames per Seconds| 10, 15, 20, 24, 30 & MAX_FPS

Video Object Performance

1. When Video Object is active, navigating to System Menu or any popup window, causes Video Object to be
inactive.

2. Video Object can be made active in both Idle and Run modes.

3. Ifactual Frames Per Second of the configured video is different from the one that is configured in Cscape,
few frames will be missed when video is played.

Web Cameras

If multiple web cameras are directly connected to the OCS, then only one web cam will be considered. If user needs
to connect multiple web cams, USB hub needs to be used. A maximum of four channels (web cameras) are sup-
ported.
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Removable Media

MICIOSD Cards ... 144
Using the Removable Media Manager .............. ... 145
oG Data . ... 145
View and Capture SCreeNS .. .. ... 146
Removable Media Object .. ... .. . . 146
FUuNCtion BIOCKS N CSCaPe .. ... o 147
Filenames 148
System Registers used with RM . . . 148

All Horner controllers models provide a Removable Media slot, labeled Memory Card, which supports standard
microSD flash memory cards. microSD cards can be used to save and load applications, to capture graphics
screens and to log data for later retrieval.

microSD Cards

When the microSD card format was introduced, it was originally called TransFlash. Cards labeled either microSD or
TransFlash, with up to 32GB of flash memory, are compatible with the Horner controller Memory Card slot.

The Memory Card slot is equipped with a “push-in, push-out” connector and a microSD card can be safely inserted
into the Memory Card slot whether the Horner controller power is On or Off.

® Toinstall a microSD card: Align its 8-pin gold edge connector down, facing the front of the Horner controller
unit as shown below; then carefully push it all the way into the Memory Card slot. Ensure that it clicks into
place.

® To remove the microSD card: Push down on the top of the card gently to release the spring. The card pops
up for removal.
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microSD File System

The microSD Memory Card slot uses the PC-compatible FAT32 File System. This means that a PC, with a
microSD-compatible card reader, can read files that have been written by the Horner controller and can write files
that can be read by the Horner controller.

However, the Horner controller does not support long filenames, but instead implements the 8.3 filename format.
This means that all file and directory names must consist of up to eight (8) characters, followed by an optional dot,
and an optional extension with up to three (3) characters.

Directories and sub-directories can be nested up to 16 levels deep as long as each path name string does not
exceed 147 characters.

Using the Removable Media Manager

The Removable Media Manager is an interactive Horner controller screen that performs the following functions:
Display number of total and free K bytes

Browse file and directory lists

Delete files and directories

Format a microSD card

Load and save application programs

View screen capture bitmaps

~®o00DD

The Removable Media Manager can be accessed via the System Menu or by using Cscape to place a Removable
Media Manager object on an application graphics screen.

Media Directory

SCRODOO .JPG 26267 07-10-08
SCROOO1 .JPG 14272 07-10-08
SCROOO2 .JPG 15209 07-10-08
SCROOO3 .JPG 29708 07-10-08
SCROOOL4 .JPG 29582 07-10-08
SCROOOS .JPG 23263 07-10-08
SCROOO6 .JPG 14643 07-10-08
SCROOO7 .JPG 14976 07-10-08
SCROOO8 .JPG 15994 07-10-08
SCROOOY .JPG 17561 07-10-08

Free: 511672320 Total: 511959040

| A] ] o 25 )59 e

Log Data

Using Read and Write Removable Media function blocks, an application ladder program can read and write Horner
controller register data in the form of comma-delimited files, with a .csv extension. These files are compatible with
standard database and spreadsheet PC programs. In addition, an application ladder program can use Rename and
Delete Removable Media function blocks to rename and delete files.
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View and Capture Screens

The Horner controller File System uses bitmap files with the .BMP extension or JPEG files with the .JPG extension
to store Horner controller graphic screen captures.

To view a captured Horner controller screen, use the Removable Media Manager to find and highlight the desired

.BMP or .JPG file, and then press Enter. ﬁ

To capture an Horner controller screen, turning on the assigned Screen Capture Control Register will capture the
current Horner controller graphics screen and write it to the microSD card using the assigned Screen Capture File-
name.

Before capturing an Horner controller screen, Cscape must first be used to assign a Screen Capture Control
Register and Filename in the application. To do this, first open the Graphics Editor by selecting the View > Edit
Screens item on the Cscape Screens menu. Next, select the Screen Capture item of the Graphics Editor Con-
fig menu and then enter a Control Register and Filename.

To capture an Horner controller screen, turning On the assigned Screen Capture Control Register will capture
the current Hornercontroller graphics screen and write it to the microSD card using the assigned Screen Capture
Filename. To view a captured Horner controller screen, use the Removable Media Manager to find and highlight
the desired .BMP or .JPG file, and then press Enter.

Removable Media Object

The configuration of the Removable Media Object that loads the Removable Media Viewer defines what buttons are
enabled and available to the user.

Theﬁ (Enter) button (if enabled) performs certain operations based on the selected file’s type:

. Change display to parent directory
<DIR> Change display to child directory
pgm Load application (if compatible model and version)

Alternately, by checking the ‘Write Selected Filename’ option, the RM Manager object will load the currently dis-
played path and filename into a block of registers for use with other Removable Media functions. The register block

is assigned in the ‘File Select’ config found in the Config menu of the graphic/screen editor.

Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer.
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Function Blocks in Cscape

NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help File in Cscape Soft-
ware. Refer to ‘USB flash Media support for RM Functions’ for USB flash drive access details.

The following RM functional blocks are available in Cscape Software. These function blocks will reference:

a. microSD when filename is prefixed with ‘A:’ or nothing
b. USB A flash drive when filename is prefixed with ‘B:’
Allows reading of a comma-separated value file from the microSD interface into the controller
Read RM csv .
register space.
. Allows writing of a comma-separated value file to the microSD interface from the controller
Write RM csv .
register space.
Rename RM . ) . .
csv Allows renaming a file on the RM card. The data in the file is not changed.
Delete RM csv| Allows deleting a file on the RM card
Copy RM csv | Allows copying a file on the RM card. The data in the file is not changed.

Program Features

a.

C.

Datalog Configuration - This feature allows the controller to periodically log register values to Removable
Media. The register data is stored in .csv (comma separated value) format, which is compatible with 3rd
party PC applications, such as Microsoft Excel.

Report Editor - This feature allows the OCS to be configured to generate text printouts which incorporate
data from the registers embedded in the text. The reports can be printed using a serial interface printer
through any of the serial ports of the OCS or can be saved on the removable media of the device.

Recipes Editor - Recipes allow the user to send or update multiple registers simultaneously.

Graphic/Screen Editor

a.
b.

Trends - The historic support feature in the trend object utilizes Removable Media.

Removable Media - This is a graphic object used to access files and functions pertaining to Removable
Media.

Recipes - This is a graphic object that is used in conjunction with the recipe editor which is mentioned above.

Additional Configuration

a.
b.

Alarms - Alarm data can be logged to a .csv file stored on Removable Media.

Screen Capture - The screen capture function allows a bitmap or jpeg image of the displayed OCS screen
to be written to the Removable Media card.

Filename Counters - The filename counters can be accessed wherever Removable Media functions
require a path name. A typical application is the auto-incrementing of a file name when doing screen cap-
tures.

File Select - File Select is used to specify the register block that is used with the Removable Media Manager
object ‘Write Selected Filename’ option.
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Filenames

The RM function blocks support the flash with a Windows standard FAT-16 file system. All names must be limited to
the “8.3” format where the filename contains eight characters a period then a three-character extension.

The entire filename including any path must be less than or equal to 147 characters.

When creating filenames and directories, it is sometimes desirable to include parts of the current date or time.
There are six special symbols that can be entered into a filename that are replaced by the OCS with current time
and date information.

Filename Special Symbols

Symbol Description Example
$Y Substitutes the current 2-digit year 2015=15
$M Substitutes the current month with a 2-digit code| March = 03
$D Substitutes the current day 22nd =22
$h Substitutes the current hour in 24-hour format | 5 pm =17
$m Substitutes the current minute 45=45
$s Substitutes the current second 34=34

NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, time symbols are in
lower case.

The following are examples of the substituted time/date filenames:
Current date and time: March 1, 2015 5:45:34 PM

Filename: Data$M$D.csv = Data0301.csv
Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\Month03\aa01_17.csv
Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\17_45_34.csv

System Registers used with RM

%SR174 — Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to the removable
media card. Write a zero (0) to allow access.

%SR175 Status — This shows the current status of the RM interface.

%SR176 Free Space — This 32-bit register shows the free space on the RM card in bytes.

%SR178 Card Capacity — This 32-bit register shows the total card capacity in kilobytes.

Possible status values are shown in the table:
RM Status Values
RM interface OK
Card present but unknown format
No card in slot
Card present, but not supported
Card swapped before operation was complete
Unknown error

QA (WIN=O
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Load CloNe .o 152

‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” application
program and unit settings stored in battery-backed RAM of an OCS into the RM. Refer to the for details in using RM.
It can then be used to clone a different OCS (exact same model).

This feature can be used for:
® Replacing an OCS by another unit of the same model.
= Duplicating or “clone” units without a PC.

Make Clone

The user needs to perform the following to Clone:

Step 1: The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the OCS. A new menu “Clone Unit” has
been added at the end of the main System Menu as shown below:

Set Networks

Uiew Status

Uiew Diags

Uiew Battery Status
View 1/0 Slots

Uiew Protocols

Set Fkeys HMode

Set Serial Ports
Set Time/Date
Set Beeper

Set Screen
Removable Hedia
Fail-Safe System

Clone Unit
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Step 2: Selecting “Make Clone” will open the following menu screen. NOTE: Free/Total — displays number of free
and total bytes in Removable Media.

WEBHI <DIR> 09-22-15 11:07a
AUTOLOAD.PGH 218545 09-22-15 10:17a
CLONE .DAT 109178 09-22-15 10:17a
EXL10E 1797901 08-14-15 10:02a
FILE  .INF 9 09-21-15 4:52p
FIRMWARE .LIC 128 09-21-15 5:24p
0EM .INF 9 09-21-15 4:52p
OEMINFO . TXT 168 04-13-12 7:16p
-

WEBHI
Free: | 7629540 Total: | 7688120

Load [ Make

Clone Clone v & Esc

Make/Create Clone option enables user to duplicate / Clone application file, all unit settings and all register values
from battery-backed RAM. Selecting Make Clone brings up the screen below for the user:

Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program or graphics. Once the
operation is completed, this bit is made zero by the firmware. When Make Clone operation is triggered by this SR
bit, it does not ask the user for confirmation for making clone. The success / failure of the operation is also not noti-
fied on screen to the user.

In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and never reset.

NOTE: Backup of registers in flash memory is not performed by Clone Feature. Refer to to the Fail-Safe System
Chapter.
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Load Clone

This option loads the application, all unit settings and register values from Removable media to the battery-backed
RAM (Regardless of AutoLoad settings) and then resets the OCS for the settings to take effect.

User needs to perform the following to Load Clone:
Step 1: Select “Clone Unit” from main System Menu of OCS as shown below:

Set Networks

Uiew Status

View Diags

Uiew Battery Status
Uiew I/0 Slots

Uiew Protocols

Set Fkeys Hode
Set Serial Ports
Set Time/Date
Set Beeper

Set Screen
Removable Hedia
Fail-Safe System

WEBMI <DIR> 09-22-15 11:07a
AUTOLOAD.PGM 218545 09-22-15 10:17a
CLONE  .DAT 109178 09-22-15 10:17a
EXL10E 1797901 08-14-15 10:02a
FILE . INF 9 09-21-15 4:52p
FIRMWARE .LIC 128 09-21-15 5:24p
OEM . INF 9 09-21-15 4:52p
OEMINFO .TXT 168 04-13-12 7:16p
hd

WEBMI
Free: | 7629540 Total: | 7688120

Load | Make

Clone | Clone V A

NOTE: For security enabled files, Load clone asks for password validation before loading the application.

Load Clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or graphics. Once the oper-
ation is completed, this bit is made zero by the firmware. When Load Clone operation is triggered by this SR bit, it
does not ask the user for confirmation for loading clone. The success / failure of the operation is also not notified on
screen to the user.

In case of failure of “Load Clone” operation, %SR164.12 bit is set to “1” by the firmware and never reset.
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Fail-Safe System
Fail-Safe System . .l 154
St NG S . 155
Backup / Restore Data ... 155
AUtoL oad .. 158
AU ORUN 160

For the XL & X Series

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of
"soft" failures. These "soft" failures include:
= Battery power loss
= Battery-Backed Register RAM or Application flash corruption due to, for example, an excessive EMI, Elec-
tromagnetic Interference, event.

For the XL Prime Series

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of
"soft" failures. These "soft" failures include:
® Retentive Register or Application flash corruption due to, for example, an excessive EMI, Electromagnetic
Interference, event.

Fail-Safe System

The Fail-Safe System has the following capabilities:

a. Manually backup the current Retentive Register Settings into flash memory.

b. Manually restore Register Settings from the values previously backed up in flash memory to battery-backed
RAM.

c. Detect corrupted Register Settings at power-up and then automatically restore them from flash.

d. Detect corrupted or empty application in flash memory at power-up and then automatically load the
AUTOLOAD.PGM application file from Removable Media (Compact flash or microSD).

e. If an automatic Register Restore or Application Load occurs, the OCS can automatically be placed in RUN
mode.

The fail-safe system can be accessed by going to the System Menu of the controller. A new menu “Fail-Safe Sys-
m” has been added at the end of the main System Menu for this. Selecting “Fail-Safe System” menu will open the
following menu screen:

Backup/Restore Data

Enable AutoRun
Enable AutolLoad

(ESC to exit)

Page 154 of 173



I.I HORNER

AUTOMATION GROUP .
Fail-Safe System

Settings

To use the Fail-Safe feature,the following steps are required:

1. From Cscape, create AUTOLOAD.PGM for the application program using ‘Export to Removable Media’.

2. Place the Removable Media with AUTOLOAD.PGM in the device.

3. Setthe ‘Enable AutoLoad’ option in the device to YES.

4. Setthe ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN mode automatically after
automatic restore of data or AutoLoad operation.

5. Backup the current battery-backed RAM Register contents in onboard flash memory using System Menu
options.

Backup / Restore Data

Selecting this option brings up a screen having four operations:
Backup OCS Data.

Restore OCS Data.

Clear Backup Data.

Exit

Backup/Restore Data

| Backup I | Restore I

| Clear Backup I

| Exit I

Backup OCS Data

When initiated, this will allow the user to manually copy battery-backed RAM contents on to the onboard flash
memory of the OCS. This will have the effect of backing up all the registers and controller settings (Network ID, etc.)
that would otherwise be lost due to a battery failure.

%SR164.4 is set to 1 when backup operation is performed.

Backup/Restore Data

Backup Register Data

Create New Backup?

Cancel I | ok I
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Restore OCS Data

When initiated, this will allow the user to manually copy the backed-up data from the onboard flash to the battery-
backed RAM.

A restore operation will be automatically initiated if 1) a backup has been previously created and 2) on power-up the
battery-backed RAM registers fail their check.

The following steps are required:
1. Place the controllerin IDLE mode.
2. Copy data from onboard flash memory to OCS battery-backed RAM
3. Resetthe Controller.
4. Putthe controller in RUN mode if the AutoRun setting is ‘Yes’, or else it will remain in IDLE mode.

Backup/Restore Data

Restore Register Data

Are You Sure?
This will cause System Reset?

| Cancel I ‘ Ok I

%SR164.3 is set to 1 only when an automatic restore operation is performed, not on a manual one. This bit is reset
to the value of “0” when a new backup is created.

Restoring of data can be manually performed by selecting RESTORE option from the Backup / Restore Data menu.
This will cause the controller to reset.

Clear Backup Data

When initiated, the backup data will be erased from the onboard flash and no backup will exist. %SR164.4 and
%SR164.3 is reset to 0 when backed up data is erased.

Backup/Restore Data

Clear Backup

Are You Sure?

Cancel 0k

Exit: Goes back to the previous screen.
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The OCS follows the following sequence in execution of Automatic Restore:

( OCS Power Cycle )

Battery Backed RAM
Registers check failed

NO
¥
Contraller placed in Application
IDLE mode FProgram erased
¥
Data copred from Cnboard FLASH to OCS Battery backed
RAM
Controller Resety
NO L
AutoFun |OCS put 1n IDLE

Enabled? Mode

OCS put i BUN Mode
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AutolLoad

This System Menu option allows the user to specify whether the OCS automatically loads the application
AUTOLOAD.PGM located in Removable Media.

When the AutoLoad setting is enabled (set to YES), it can either be manually initiated or automatically initiated at
power-up.

The automatic initiation will happen only in the following two cases:
® When there is no application program in the OCS and a valid AUTOLOAD.PGM is available in the removable
media of the device.
= When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is available in the
removable media of the device.

AutoLoad can be manually initiated when the SYS-F3 key is pressed (OCS can be in any of the following mode —
Idle / Run/ DOIO). This also requires a valid AUTOLOAD.PGM to be present in the removable media of the device.
When the AutolLoad setting is not enabled (set to NO), OCS will be in IDLE mode and the application is not loaded.

If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password before loading the
application. The application will be loaded from the Removable media only after getting the correct password.

%SR164.6 can be set to enable AutolLoad feature.

Enable AutolLoad

{ AutoLoad from )
{ Removable Media’s )
{ AUTOLOAD.PGH file )
( when triggered )

No = Does not load AUTOLOAD.PGM automatically when application program
is absent or corrupted.

Yes = Loads AUTOLOAD.PGM file automatically from Removable Media
when application program is absent or corrupted.

Enable AutoLoad
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The OCS follows the following sequence in execution of AutoLoad:

( Power up OCS )

¥
Apphecation Program absent
o
Application Program corrupted

NO
AutoLoad

Enabled?

ki

OCS put i IDLE mode

NO AuntoLoad run sequence

farled (with reasons for
failure)

AUTOLOAD PGM present 1
the BN of the device 7

AutoLoad mitiated.

NO

AuntoFEun
Enabled?

k4

QCS put in IDLE Mode

OCS put in RUN Maode
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AutoRun

This System Menu option, when enabled (YES), allows the user to automatically place the OCS into RUN mode
after the AutoLoad operation or automatic Restore Data operation.

When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore Data or AutoLoad
operation.

%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad has been performed
or an Automatic Restore has occurred.

If for any reason the AutoLoad-Run (Loading the AUTOLOAD.PGM automatically and OCS put in RUN mode)
sequence does not succeed, a pop-up message box saying "AUTO-LOAD-RUN SEQUENCE FAILED" will be dis-
played. It will also show the reason for its failure. On acknowledging this message box, the AutoLoad-Run
sequence will be terminated, controller will return to the first user-screen and will be placed in IDLE mode.

Enable AutoRun

{ ¥k 2CAUT ION*k*£%%)
( Auto Enters RUN )
{ after AutoLoad )
{ or Battery Fail )

Enable AutoRun No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.
Yes = OCS will automatically be placed into RUN mode after AutoLoad or Automatic Restore.

“Enable AutoLoad” displays the following options:

No = Does not load AUTOLOAD.PGM automatically when application program
is absent or corrupted.

Yes = Loads AUTOLOAD.PGM file automatically from Removable Media when
application program is absent or corrupted.

Enable AutoLoad
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Modbus Communications

ModbUS Slave OVerVIeW .. 162
Modbus Master OVerVieW . .. 163
Modbus Addressing Table ... ... . . 164

For complete Modbus instructions, please refer to the Help file in Cscape.

Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices from multiple manufacturers
to easily share data in real-time. For Modbus serial communications, the X5/X5 Prime can act as either a Master or
a Slave.

Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the conversation by
sending a request to a particular slave. Only the addressed slave will send a response when the request is com-
pleted. Should the slave be unable to complete the request, it returns the appropriate error response. Should the
slave be unable to respond, the master’s timeout timer expires to provide an indication of No Response.

Modbus Slave Overview

The Modbus slave function block, when used with the appropriate Modem and/or Open Function Blocks, allows the
primary serial port on the controller to act as a Modbus slave. The Modbus function supports both ASCIl and RTU
modes of operation across a range of baud rates and protocol frames. Also supported is port activity status, an
inactivity timer, support for call-on exception, and support for store and forward (repeater) operation for radio
modems.

The Modbus Addressing section describes the supported Modbus Commands as well as the Modbus Map for
X5/X5 Prime References (%R, %M, etc.).
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Modbus Master Overview

For complete Modbus Master instructions, please refer to the Help file in Cscape.

When acting as a Modbus master, there are two primary mechanisms used by the X5/X5 Prime to allow the user to
specify the data to be read/written from/to the slaves.
Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be used in

rare occasions.
Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in Cscape (serial).

Refer to the Modbus Addressing section. This is the preferred method in most applications.

After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List become avail-
able. The Protocol Config is configured on three different levels:
= Network—Parameters, such as the polling rate of the data scan, are specified along with timeout values,
retry, and re-acquisition settings. Serial configuration, baud rate, parity, etc. are also set here.
= Devices—For every slave to be polled, configuration details are added in the Devices dialog box. This
includes Slave ID (serial). Under Device Type, the Modbus addressing style matching that specified in the
slave’s user documentation may be selected. For instance, some slaves specify Modbus addresses (i.e.

40,001), and others specify offsets (i.e. 0000).
= Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the user to

select the Modbus addressing style for each slave on the network, minimal address conversion is
required. Also, if the slave is another Horner product (i.e. another OCS), the “Native Addressing”
option can be selected (i.e. %R1, %M17, etc.), and this skips the conversion to Modbus style alto-

gether.
® Scan List—This is where the specific Modbus addresses to be read/written from/to each slave are specified.

Up to 32 words of data can be read at the same time.

NOTE: Once configuration has been completed on the Network and Devices level, Modbus data can be directly
read/written from graphics objects in the Cscape screen editor. This is available even if the Modbus register is not

listed on the scan list.
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Modbus Addressing Table

To access X5/X5 Prime registers, a Modbus Master must be configured with the appropriate register type and off-
set. This is usually accomplished with one of two methods:

Method 1: The first method uses Traditional Modbus References, in which the high digit represents the register
type, and the lower digits represent the register offset (starting with Register 1 for each type). Since only four
register types can be represented in this manner, X5/X5 Prime Modbus Function Blocks pack several X5/X5 Prime
register types into each Modbus register type. Starting addresses of each X5/X5 Prime register type are shown in
the Traditional Modbus Reference column of the Mobus Table.

Method 2: The second method requires the Modbus Master to be configured with a specific Modbus Command and
Modbus Offset. The supported Modbus commands and the associated offsets are also illustrated in Modbus Table.

X5 / X5 Prime Modbus Master Mapping
X5 Maximum Trad. Modbus Refer| Expanded Modbus Modbus Command | Modbus Off-
Reference Range ence R?f'. (s) set
(5 Digits) (6 Digits)

%I1 2048 10001 010001 0

%IG1 256 13001 013001 3000

%S1 256 14001 014001 Read Input Status (2) 4000

%K1 4 15001 015001 5000

%Q1 2048 00001 000001 0

%M1 2048 03001 003001 Read Coil Status (1) 3000

Force Coil (5)

%T1 2048 06001 006001 Force Multiple Coils 6000
%QG1 256 09001 009001 (15) 9000
%Al1 512 30001 030001 0
%AIG1 32 33001 033001 Read Input Register 3000
%SR1 256 34001 034001 (4) 4000

%AQ1 512 40001 040001 0
%R1 2488 40513 040513 Read Holding Register| 512
%R1 2048 43001 043001 (L‘and Register (6) 3000

%AQG1 32 46001 046001 Load Multiple 6000
%R1 8192 - 410001 Registers (16) 10000
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Check for Current Firmware Revision

Firmware Update Details
Download Firmware

The X5/X5 Prime OCS products contain field updatable firmware to allow new features to be added to the product.
Firmware updates should only be performed when a new feature or correction is required.

WARNING: Firmware updates should only be performed when the equipment being controlled by the OCS
is in a safe, non-operational state. Communication or hardware failures during the firmware update pro-
cess can cause the controller to behave erratically resulting in injury or equipment damage. Make sure
the functions of the equipment work properly after a firmware update before returning the device to an

operational mode.

Check for Current Firmware Revision

To check the firmware revision on a controller, open System Menu > View Status.
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Firmware Update Details

NOTE: Updating firmware will clear the application program, screens, configurations, and register data. If required,
make sure to backup program and register data before updating firmware. The controller's User Manual has instruc-
tions for doing backups.

There are two methods for updating firmware. The method used depends on the type of controller being updated.

Method A: Removable Media Method — The controller firmware is updated by a bootloader, using a microSD card
or USB Flash drive (not through the Cscape Firmware Update Wizard). To update or change firmware:
1. Download desired Firmware set from the Horner APG website. (Verify CsSCAN or CANopen com-
munications.)
2. Save Firmware files to microSD card or USB, these are the removable media devices.
3. Update the firmware through the controller’'s Firmware Update function

NOTE: Files from the Horner website come as a .ZIP file which need to be unzipped and placed in the root of the
drive for them to function properly.

Method B: RS232 Serial Connection — Serial firmware updates are done from Cscape software to the controller’s
primary serial port, MJ1 in most cases.

Download Firmware

In North America, visit https://hornerautomation.com. Then click Support > Downloads > Controller Firmware
and download the most recent firmware set with the correct communication protocol.

-OR-
In Europe, visit http://www.hornerautomation.eu and click Support > Firmware tab and download the desired firm-
ware (an account is required to access firmware updates, create one if necessary).

Firmware Update Steps

Unzip all files from downloaded .zip file (see "Download Firmware" above) onto removable media.
Plug removable media into a powered-up controller.

Touch the upper-right-hand screen corner to slide out the control panel.

Press and hold the SYSTEM key until the Boot Installer screen appears. Select System upgrade option.
Boot Installer screen appears.

Press the Install Bootloader button and then press Yes.

When Operation Completed appears, press OK.

Power-cycle the controller and wait for it to boot up.

Touch the upper-right-hand screen corner to slide out the control panel.

Press SYSTEM key, select View Status and press the Enter button.

If any of the version numbers are incorrect, verify the correct files were copied to the removable media
device and repeat the steps above.

PON=

cCoONDO

For more Firmware Update information refer to the Firmware Update Manual, MAN1011, which can be found on the
Horner website.
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Connecting to the OCS

Cscape connects to the local controller automatically when the serial connection is made. The status bar below
shows an example of a successful connection. This status bar is located in the bottom right-hand corner of the
Cscape window.

Local 253 Target:253(R) [no forces]

In general, the Target number should match the Local number. The exception to this is when the controller is being
used as a "pass through" unit where other controllers on a CsCAN network could be accessed through the local con-
troller. See Cscape Help File for more details.

Determine connection status by examining feedback next to Local & Target in the status bar of Cscape.

Cscape Target & Local Numbers

L;;;k If a number shows next to Local then communication is established to the local controller.
Local: Cscape is unable to access the COM port of the PC. This could mean that Cscape is configured for a
No Po-rt COM port that is not present or that another program has control of the COM port. Only one Cscape win-

dow can access a port at a time. Subsequent instances of Cscape opened will indicate No Port.

Local: | Cscape has accessed a PC COM port but is not communicating with the controller. This typically occurs

No Com| when the controller is not physically connected.

Local: | Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape with a
??? | blank project. Check Local.

Target: | If| (idle), R (run), or D (do I/O) shows next to Target number, then communication is established to the

#(I,R,D) | target controller.

Target: | Communication is not established to the target controller. Check node ID of controller and set Target to
#(?) | match. Make sure local connection is established.

Serial Port — MJ1 Programming

1. Controller must be powered up.

2. Ensure that the correct COM port is selected in Cscape. Tools > Applications Settings > Com-
munications.

3. Ensure that a cable with proper pinout is being used between PC and controller port MJ1.

4. Check that a Loaded Protocol or ladder is not actively using MJ1. Taking the controller out of Run Mode from
the System Menu on the controller will make MJ1 available to Cscape.

5. Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG offers a USB to serial
adapter: part number HE-CPK.
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USB Port - Mini B Programming

1.
2.

3.

Controller must be powered up.

Ensure that the correct COM port is selected in Cscape.Tools > Applications Settings > Com-
munications.

Be sure that the USB cable is connected between the PC and the controller. Check Windows Device Man-
ager to ensure that the USB driver is properly installed and to verity the port number.

ETN Port Programming

1.

Controller must be powered up.

Ensure that the correct IP address is given in the Ethernet field and correct Mode is selected, in Cscape:
Tools > Applications Settings > Communications.

Ensure that an Ethernet connection has been established by pinging the controller from the Windows DOS
prompt.

Local Controller and Local I/O

The System Menu provides the following status indications that are useful for troubleshooting and system main-
tenance. To view the System Menu, press the System key.

Self-test results, diagnostics.
RUN and OK status

Network status and usage
Average logic scan rate
Application memory usage
Loaded firmware versions
Loaded protocols
Removable media access

Local I/O Troubleshooting Checklist

1.
2.

o0k w

Verify the controller is in RUN mode.

Check diagnostics to ensure controller passed self-tests. View Diags in System Menu or in Cscape, click
Controller/Diagnostics.

Check data sheets to ensure proper wiring.

Ensure that hardware jumpers and software configuration for /0O match.

Check data sheets for voltage and current limits.

Take ladder out of the picture. From Cscape set controller to “Do I/O” mode. In this mode inputs can be mon-
itored, and outputs set from a data watch window in Cscape without interference from the ladder program.
Some I/O problems are only a result of a mistake in the ladder program.

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage in an
unsafe manner depending on the application and the environment.
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CsCAN Network

For complete information on setting up a CsCAN network, refer to CAN Networks manual (MANO799) by using
Horner's Documentation Search page.

Network status, node ID, errors, and baud rate in the controller System Menu are all in reference to the CsCAN net-
work. These indications can provide performance feedback on the CsCAN network and can also be used to aid in
troubleshooting.

CsCAN Network Troubleshooting Checklist

1.

2.

3.

12.
13.

14.

Use the proper Belden wire type or equivalent for the network as specified in the CAN Networks Manual,
MANOQ799.

The Horner OCS does not provide 24VDC to the network. An external voltage source must be used for other
devices such as SmartStix I/0.

Check voltage at both ends of the network to ensure that voltage meets specifications of attached devices.
Proper termination is required. Use 121Q (or 120Q) resistors at each end of the network. The resistors
should be placed across the CAN_HI and CAN_LO terminals.

Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and terminated,
there should be around 60Q.

Check for duplicate node ID’s.

Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used for CAN_HI
and CAN_LO.

Make sure the baud rate is the same for all controllers on the network.

Assure shields are connected at one end of each segment—they are not continuous through the network.
Do not exceed the maximum length determined by the baud rate and cable type.

. Total drop length for each drop should not exceed 6m (20°). A drop may include more than one node. The

drop length adds to the overall network length.

Network should be wired in "straight line" fashion, not in a "star" pattern.

In applications requiring multiple power supplies, make sure the V- of all supplies is connected and to earth
ground at one place only.

In some electrically noisy environments, it may be necessary to add repeaters to the network. Repeaters can
be used to add additional nodes and/or distance to the network and protect the signal against noisy envir-
onments.

USB Interfaces

® Plugging and unplugging USB devices while the OCS is powered up can cause the OCS to reset. In general,

branded USB memory sticks will not cause this problem, however, with the advent of USB 3.0 and larger /
faster memory devices this cannot be guaranteed.

Larger USB devices such as hard-drives etc. should only be attached and removed when the OCS is
powered down.

The resets are caused by short sharp current spikes when devices are added or removed from the OCS,
these spikes can exceed the USB specification but are usually very short and mostly do not cause problems.
Some devices however draw a longer larger current as they power up causing a brief dip in the OCS internal
supplies leading to a reset.

Standard SanDisk and Kingston ranges with read times less than 120MB/sec. should not cause resets. The
display will flicker when a device is added or removed.
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Basic Troubleshooting

Description Action
OCS doe§ not The media card should be formatted with the controller.
read media card.
OCS will not . - ) ) o )
Make sure the project file is saved as a .pgm file and not a .csp file. In addition, the file must be
download pro- o ) . ) . .
ject file .pgm. The file's I/O configuration must match the controller configuration for it to download.

Technical Support Contacts

For manual updates and assistance, contact Technical Support at the following locations:

North America:

Tel: (317)916-4274

Fax: (317) 639-4279

Website: https://hornerautomation.com
Email: techsppt@heapg.com

Europe:

Tel: (+) 353-21-4321-266

Fax: (+353)-21-4321826

Website: https://www.hornerautomation.eu
Email: technical.support@horner-apg.com
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Date Eev Description of Revision

Updated Firmware Update Steps per new Firmware Update Manual (Mantis 2209)
8/5/2020 |8 Rearranged Chapter order (Mantis 3029)
Updated back panel image with red CAN connector (Mantis 2802)

WebMI Registers Updates (4845)

Added section about 121Q resistor for CAN Communication. (3467)

5/2/2021 9 Definition of EMI in Fail-Safe chapter. (4567)

Replaced HSC Register table with correct one from earlier draft of user manual. Removed

table with four counter information. (2909)

WebMI — Max # of connections (4802)
8/16/2021 | 10| Ao Limit added (6103)

8/2/2022 | 11 Added X5 Prime to User Manual (8395)
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